
 

 

  

LKS TIK Kelas 
VIII Semester 2 

Lembar Kerja Siswa TIK kelas 8 Semester 2 Ini berisi 
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BAB 1 
PERANGKAT LUNAK PENGOLAH ANGKA 

 
Standar Kompetensi: 
Menggunakan perangkat lunak pengolah kata untuk menyajikan informasi 
 
Kompetensi Dasar: 
Mengidentifikasi menu dan ikon pada perangkat lunak pengolah angka 
 
Kelas/semester: 
VIII/Genap 
 
Karakter Siswa yang Diharapkan 
Kerja Keras, Kreatif, Rasa Ingin Tahu 
 
Ringkasan Materi 
 
A. Perangkat Lunak Pengolah Angka 
Perangkat aplikasi pengolah angka adalah software (perangkat lunak) khusus untuk menangani 
permasalahan yang berkaitan dengan angka. Dalam hal ini, angka yang sering muncul di bidang 
bisnis, ilmiah, perencanaan, pembuatan statistik, pembuatan lembar kerja, pengelolaan angka untuk 
perhitungan sebuah data (basis data) dan grafik. 
 
Macam-macam Perangkat Lunak Pengolah Angka 
Macam-macam perangkat lunak pengolah angka antara lain : Kspread, Star Office Calc, Open Office 
Calc, GNOME - GNumeric, Xess, Lotus 123, Microsoft Excel. Adapun yang sekarang banyak digunakan 
masyarakat adalah Microsoft Excel. 
Kspread 
Kspread merupakan aplikasi pengolah angka (spreadsheet) yang bersifat open 
source dan multiplatform. Open Source berarti kita dapat mendownload secara gratis dari internet 
dan menggunakannya secara bebas. 

 
Gambar Kspread beserta lembar kerja 

Star Office Calc 
StarOffice Calc merupakan aplikasi pengolah angka yang dikembangkan oleh Sun Microsystem. 
StarOffice Calc adalah aplikasi pengolah angka yang bersifat multiplatform, yang berarti dapat 
dijalankan di berbagai sistem operasi termasuk Linux, Solaris, Unix, dan Windows 
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Gambar Star Office Calc beserta lembar kerja 

Open Office Calc 
OpenOffice Calc adalah aplikasi pengolah angka yang besifat open source (dapat dibuka melalui 
sistem operasi apa saja). 

 
Gambar Open Office Calc beserta lembar kerja 

GNOME Office - Gnumeric 
Gnumeric adalah aplikasi pengolah angka yang merupakan keluarga dari GNOME Office. Gnumeric 
bersifat open source. Gnumeric memiliki tampilan yang user friendly di mana jendela Gnumeric 
dilengkapi dengan menu-menu dan tombol-tombol toolbar. 

 
Gambar GNOME Office - GNUMERIC beserta lembar kerja 
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Abacus 
Abacus adalah aplikasi pengolah angka yang hanya membutuhkan memori kecil dan sangat mudah 
digunakan. Awalnya Abacus dikembangkan sebaggai proyek mahasiswa di Universitas IST, Portugal 
di bawah bimbingan Prof. Arlindo Oliveira. 

 
Gambar Abacus beserta lembar kerja 

XESS 
XESS adalah aplikasi pengolah angka yang dibuat oleh AIS (Applied Information System - 
www.ais.com) dan dapat dijalankan dikomputer dengan sistem UNIX, Linux, Open 
VMS dan Windows. 

 
Gambar 2.6 : XESS beserta lembar kerja 

Lotus 123 
Lotus 123 merupakan aplikasi pengolah angka yang dikeluarkan IBM. Lotus 123 dikeluarkan dalam 
satu paket bersama-sama aplikasi Office lainya dan dikenal dengan nama Lotus SmartSuite. 
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Gambar Lotus 123 beserta lembar kerja 

Microsoft Excel 
Microsoft Excel (MS Excel) adalah program aplikasi pengolah angka/spreadsheet yang dibuat oleh 
perusahaan software raksasa Microsoft Corporation. MS Excel terdapat dalam satu paket MS Office. 
Ada beberapa versi dari MS Excel, diantaranya versi 97, 2000, 2001/XP, 2003, dan versi terbaru 2007 
yang akan kita gunakan  sekarang. Beberapa keuntungan mengunakan MS EXCEL 2007 adalah 
sebagai berikut: 
1. Banyak fitur lebih mudah dieksplorasi dibanding ms excel 2003. 
2. Rumus-rumusan dan Formula pada Excel lebih mudah direferensikan. 
3. Tampilan menu yang praktis sehingga akan mempercepat Anda dalam bekerja. 
4. Microsoft Excel 2007 menyediakan 1.084.576 baris dan 16.384 kolom. Jauh lebih banyak 

daripada Ms Excel 2003 
5. Anda bisa  memanfaatkan berbagai theme yang akan mempermudah Anda dalam memformat 

data. 
6. Terdapat conditional formatting untuk mempermudah penandaan data secara visual untuk 

keperluan analisis dan presentasi data. 
7. Fungsi AutoComplete yang dapat menuliskan sintak-sintak rumus dengan tepat. 
8. Tampilan grafik lebih memukau yaitu mempunyai efek-efek tiga dimensi, transparansi, dan 

bayangan objek. Tidak jadul-jadul amat. 
9. Fitur Sharing antar aplikasi dapat difungsikan dengan mudah antar aplikasi Office seperti Word 

dan Power Point. 
 
B.Memulai Aplikasi Microsoft Office Word 2007  
Untuk membuka Microsoft Word caranya adalah:   
1. Klik Tombol Start yang ada di taskbar.   
2. Pilih menu All Program dan muncul sejumlah menu 
3. Kemudian arahkan pointer ke Microsoft Office dan klik program aplikasi Microsoft Office Excel 

2007  
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4. Tunggu sampai jendela Microsoft Office Word 2007 ditampilkan.  

 
Selaian cara di atas, cara yang paling mudah untuk dilakukan adalah dengan cara klik dua kali 
shortcut Microsoft Word yang berada di desktop. Atau jika mengalami kesulitan, klik satu kali, 
kemudian tekan tombol enter. 
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Silahkan Anda pilih salah satu cara tersebut. Jika sudah dipilih, berikut lingkungan kerja dari MS Excel 
2007 

 
Tampilan lingkungan kerja MS Excel 2007 

 
Keterangan: 

 
1. Tombol Microsoft Office, hampir sama dengan menu file pada Microsoft Word versi 

sebelumnya (2000, XP, dan 2003). Berisi menu new, open, save, print, dan sebagainya.  
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2. Toolbar Quick Access, yang secara default toolbar ini 
menyediakan tombol Save, Undo,  

 dan Repeat. Namun dapat ditambah dengan mengklik gambar panah (drop down) di ujung 
kanan toolbar ini   dan tandai yang belum ditampilkan atau klik More Commands.  

3. Title bar, yang terletak paling atas pada jendela word. Title bar ini menampilkan nama 
dokumen yang sedang kita buka. Untuk dokumen yang belum disimpan/diberi nama maka 
Microsoft Word akan menampilkan file tersebut  dengan nama Document 1, 2, 3 dan 
seterusnya.  

4. Tombol Close, Tombol tersebut berfungsi menutup aplikasi Microsoft Word.  
5. Ribbon, Berisi beberapa tab yang berisi beberapa group icon.   
6. Scroll bars, Berfungsi untuk menggeser layar kerja.  Jika ingin menggeser layar kerja ke kiri 

atau ke kanan gunakan horizontal scroll bar, atau menggeser layar kerja ke atas dan 
kembawah gunakan vertical scroll bar.   

7. Status bar, memberikan informasi tentang letak insertion point, halaman, section, jumlah 
halaman, dan bahasa yang digunakan.   

8. Kontrol Zoom. Digunakan untuk menentukan ukuran tampilan lembar kerja di layar pada 
jendela word. 

9. Column Header (Kolom) tersusun secara mendatar dari kiri ke kanan (horizontal), tersusun 
secara abjad mulai dari huruf A sampai Z, dilanjut dengan AA sampai XFD. Lebar kolom dapat 
diatur sesuai kebutuhan (max. 255). 

10. Row Header (Baris) tersusun secara tegak lurus dari atas ke bawah (vertikal), ditandai dengan 
angka 1, 2, 3, - 1048576 baris. Tinggi baris dapat diatur sesuai kebutuhan (max. 409). 

11. Tab Sheet (Tab Lembar Kerja) secara otomatis saat pertama kali membuka lembar kerja MS-
Excel terdiri dari 3 sheet, dan sheet ini bisa ditambah, diubah namanya, dan dihapus. 
Caranya adalah : 
Klik kanan di bagian Sheet (misalnya di Sheet 1) lalu pilih : 
Insert : untuk menambah sheet 
Delete : untuk menghapus sheet 
Rename : Untuk mengganti nama sheet 

12. Status bar (baris status) menampilkan informasi & pesan-pesan yang terletak di bagian bawah 
jendela MS-Excel seperti keaktifan insertion point (posisi kursor), keaktifan beberapa tombol 
keyboard, language (ejaan bahasa) yang digunakan, dll. 

13. Scroll bar (baris penggulung) : untuk menggeser layar ke atas atau ke bawah (vertical) dan 
dari kanan ke kiri atau sebaliknya (horizontal). 

14. Sel (Cells) : merupakan pertemuan antara kolom dan baris. Penyebutan alamat sel 
berdasarkan alamat kolom diikuti dengan baris. Contoh : C1, artinya di kolom B pada baris ke-
1. 

15. Range (Sekumpulan sel) : penyebutan alamat range seperti halnya sel, karenarange terdiri 
dari banyak sel maka penyebutannya dari alamat sel kiri atas s/d sel kanan bawah yang 
dipisahkan dengan tanda : . Contoh : kumpulan sel yang dimulai dari D4 hingga H14 
dinyatakan sebagai range D4:H14. 

 
C.Elemen Dasar MS EXCEL 2007 
1. Title Bar Excel 2007 
Title bar adalah batang yang menampilkan judul dari program yang sedang berjalan dan nama 
dokumen yang sedang dikerjakan. 
 

 
Title Bar Excel 2007 
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Pada title bar Excel 2007 ditampilkan pula ikon program di sudut kiri –yang jika diklik kanan akan 
menampilkan menu popup control menu dan tiga buah Control Command, yakniminimize, 
maximize/restore dan close. Minimize digunakan untuk menyembunyikan program dan menyimpan 
pada task bar dengan bentuk tombol (button). Maximized digunakan untuk mengubah tampilan 
ukuran program satu layar monitor. Close digunakan untuk menutup program aplikasi. 
 
2. Office Button Excel 2007 
Tombol berbentuk bulat dengan logo Office di tengahnya. Tombol Office Button Excel 2007 
digunakan untuk memanajemen berkas dokumen (document file) yang akan atau telah diproses oleh 
Microsoft Office Excel, klik tombol ini, dan Anda akan menemukan beberapa tombol lain di 
dalamnya, seperti tombol New, Open, Save, dan Print. 

 
Gambar Office Button berisi beberapa perintah manajemen dokumen 

 
Keterangan: 

Nama Icon Keterangan 

New digunakan untuk membuat file dokumen kosong baru 

Open digunakan untuk membuka file dokumen yang tersimpan 

Save perintah untuk menyimpan file dokumen aktif 

Save As digunakan untuk menyimpan file dokumen ke dalam format tertentu 

Print digunakan untuk mencetak file dokumen yang sedang aktif 

Prepare digunakan untuk melakukan properti khusus terhadap file dokumen aktif 

Send digunakan untuk mengirimkan file dokumen aktif sebagai email / faksimile 

Publish perintah untuk menerbitkan dokumen aktif ke website / blog / dll 

Close digunakan untuk menutup file dokumen aktif 

 
3.Ribbon   
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Ribbon berisi ikon-ikon yang digunakan untuk menjalankan suatu perintah dengan cepat dan mudah, 
khususnya perintah-perintah yang sering digunakan. Ribbon terdiri dari Tab yang terbagi atas Home, 
Insert, Page Layout, Formula, Data, Review, View. Di setiap tab terdapat Group dimana setiap 
group dikelompokkan berdasarkan kesamaan fungsinya. Perintah-perintah dalam group ditandai 
dengan gambar (ikon). 

 
Gambar Ribbon 

 
4.Quick Access Tool Bar Excel 2007 
Quick Access Tool Bar Excel 2007- Quick Access Toolbar adalah batang yang berisi tombol-tombol 
untuk jalan pintas dari pemanggilan perintah-perintah tertentu. Ini memudahkan Anda untuk 
mengelompokkan tombol-tombol yang akan sering Anda gunakan, seperti tombol untuk membuat 
dokumen baru, menyimpan dokumen, dan mencetak dokumen. 
 

 
Gambar Tampilan Quick Access Toolbar 

 
Anda dapat menambahkan atau mengurangi tombol-tombol yang telah tersedia pada Quick Access 
Toolbar dengan cara, klik tombol anak panah di ujung kanan Quick Access Toolbar, klik More 
Commands. 

 
Gambar Langkah memasukkan perintah baru ke Quick Access Toolbar. 

 
(a) Klik More Commands 
(b) Klik Add>> untuk Menambahkan 
Pada dialog yang ditampilkan, pilih sebuah tombol perintah yang ingin ditambahkan. Sebagai contoh, 
pilih tombol perintah New, kemudian klik tombol Add >>. Kemudian, pada daftar tombol yang sudah 
dipilih, klik baris New yang tadi Anda pilih, lalu klik tombol anak panah ke atas, untuk mengatur 
urutan posisi tombol. Tambahkan tombol-tombol lain, dan atur urutan posisinya sehingga 
menghasilkan tampilan seperti berikut. 
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Gambar Separator untuk memisahkan tombol grup 

 
Jika perlu tambahkan <Separator> (pembatas) untuk memisahkan tombol grup. Klik tombol OK, dan 
lihatlah tampilan tombol Quick Access Toolbar pada tampilan aplikasi Anda sekarang. 
 
D.Menu di  Microsoft Excel 2007 

Menu dan Ikon Microsoft Excel 2007 ditampilkan dalam bentuk Ribbon. Ribbon (pita) adalah 
kontrol baru yang mengganti penggunaan menu dan toolbar pada MS Excel versi terdahulu. Kenapa 
disebut ribbon (pita), karena bentuknya menyerupai pita yang terpasang dari kiri ke kanan 
menyerupai pita yang terpasang pada mesin tik atau printer dot matrik. Di dalam ribbon ini 
disediakan tool-tool (tombol-tombol) untuk mempermudah Anda menggunakan program aplikasi. 
Tombol-tombol pada ribbon dikelompokkan menjadi beberapa grup tertentu, kemudian di 
organisasi menjadi beberapa halaman tab ribbon. 
 

 
Gambar  Ribbon pada MS Excel 2007 

 
Secara default, ribbon menampilkan tujuh halaman tab. Berikut ini penjelasan setiap tab tersebut. 
 
a. Fungsi Menu dan Ikon tab Home 
Halaman pada ribbon ini berisi tombol-tombol untuk melakukan pengeditan terhadap dokumen 
yang sedang Anda kerjakan. Untuk dapat mengakses halaman ribbon Home, Anda dapat melakukan 
dengan mengklik tab Home. Anda juga dapat menggunakan keyboarddengan menekan tombol Alt + 
H. Langkah ini akan menampilkan kotak-kotak kecil bertuliskan huruf akses cepat bagi setiap 
perintah pada tab Home. Tekan tombol Alt kembali untuk menonaktifkan huruf akses. 
 

  
Gambar Tampilan tab Home 

 
Tabel Fungsi Menu dan Ikon Tab Home. 
 

Menu Tab Home 

Kelompok Clipboard 

Paste Menempelkan hasil perintah cut/copy yang ada di clipboard 

Cut Memindahkan bagian yang ditandai ke clipboard 

Copy Menyalin ke clipboard 
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Format Painter Melakukan copy format 

Kelompok Font 

Font Selection Mengganti jenis huruf 

Font Size Mengatur ukuran huruf 

Increase/Decrease Font Menaikkan dan menurunkan ukuran font satu tingkat 

Bold, Italic, Underline Menebalkan, memiringkan, menggarisbawahi teks 

Border Membuat garis bingkai sel 

Fill Mewarnai sel 

Color Mewarnai huruf 

Kelompok Aligment 

Vertical Alignment Mengatur posisi teks secara vertikal pada sel. 
Atas, tengan, dan bawah 

Perataan teks Mengatur perataan teks, kiri, tengah, dan kanan 

Indent Menambah dan mengurangi inden teks 

Teks Orientation Mengubah kemiringan teks 

Merge Cell Menggabungkan sel 

Page Break Mengatur pemisah halaman 

Kelompok Number 

Format Cell Pengaturan jenis penulisan angka 

Currency Format angka untuk mata uang 

Persen Format angka persen 

Comma Mengubah nilai koma ribuan 

Increase/Decrease Decimal Menambah dan mengurangi nilai desimal 

Kelompok Style 

Conditional Formatting Melakukan format terkondisi 

Format as Table Membuat format tabel cepat 

Cell Styles Membuat format sel secara cepat 

Kelompok Cells 

Insert Memasukkan sel baru 

Delete Menghapus sel 

Format Melakukan format sel 

Kelompok Editing 

Sum Melakukan penghitungan 

Fill Membuat pola angka secara kontinu 

Clear Menghapus semuanya dari sel, nilai, hingga format 

Sort & Filter Mengatur data agar mudah dianalisis 

Find & Select Mencari dan menyeleksi teks dalam lembar kerja 

 
b. Fungsi Menu dan Ikon tab Insert 
Halaman pada ribbon ini berisi tombol-tombol untuk menyisipkan objek-objek ke dalam naskah, 
seperti Picture (gambar), Clip Art (seni klip), Chart (grafik/diagram), dan Tabel. 

 
  

Gambar Tampilan tab Insert 
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Tabel Fungsi Menu dan Ikon Tab Insert. 
 

Menu Tab Insert 

Kelompok Tables 

Pivot Table Memasukkan tabel pivot 

Table Memasukkan tabe 

Kelompok Ilustrations 

Picture Menambahkan gambar pada worksheet 

Clip Art Menambahkan gambar clipart pada worksheet 

Shapes Menambahkan gambar bentuk tertentu 

Smart Art Memasukkan objek smartart 

Kelompok Chart 

Coloumn Memasukkan grafik kolom 

Line Memasukkan grafik garis 

Pie Memasukkan grafik pie 

Bar Memasukkan grafik batang 

Scatter Memasukkan grafik distribus 

Other Chart Memasukkan grafik lainnya 

Kelompok Link 

Hyperlink Memasukkan hyperlink pada worksheet 

Kelompok Text 

Textbox Memasukkan kotak teks 

Header & Footer Memasukkan header dan footer 

WordArt Memasukkan teks dekoratif 

Signature Line Memasukkan garis tanda tangan 

Object Memasukkan objek 

Symbol Memasukkan simbol 

 
 
c. Fungsi Menu dan Ikon tab Page Layout 
Halaman pada ribbon ini berisi tombol-tombol untuk mengatur tampilan kertas dari naskah yang 
sedang dikerjakan, seperti mengatur Margins (batas awal dan batas akhir pencetakan kertas), 
Orientation (posisi pencetakan kertas, tegak atau mendatar), Size (ukuran kertas yang akan 
digunakan), Columns (tampilan bentuk kolom), dan sebagainya. 
 

 
Gambar Tampilan tab Layout 
 
 
Tabel  Fungsi Menu dan Ikon Tab Page Layout. 
 

Tab Page Layout 

Kelompok Themes 

Theme Mengubah tema tampilan excel 
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Color Mengubah warna tema 

Font Mengubah jenis font tema 

Effect Mengubah efek tema 

Kelompok Page Setup 

Margin Mengubah margin halaman 

Orientation Mengubah orientasi halaman 

Size Mengubah ukuran kertas 

Print Area Menentukan area tertentu untuk proses cetak 

Breaks Menentukan pemisah halaman 

Background Menentukan gambar untuk latar 

Print Title Menentukan baris atau kolom yang dicetak pada setiap halaman 

Kelompok Scale to Fit 

Width Menentukan lebar hasil cetak agar sesuai banyaknya kertas 

Height Menentukan tinggi hasil cetak agar sesuai banyaknya kertas 

Scale Memperbesar atau memperkecil hasil cetak sesuai 
persentase Ukuran 

Kelompok Sheet Option 

Gridlines Mengatur tampilan garis grid di layar dan di hasil cetakan 

Heading Mengatur tampilan header di layar dan di hasil cetakan 

Kelompok Arrange 

Bring to Front Objek ke depan 

Send to Back Objek ke belakang 

Selection Pane Memperlihatkan panel seleksi objek 

Align Meluruskan objek 

Group Mengelompokkan objek 

Rotate Melakukan rotasi objek 

 
 
d. Fungsi Menu dan Ikon tab Formula 
Halaman pada ribbon ini berisi tombol-tombol untuk mengolah dokumen dengan formula-formula 
yang telah disediakan oleh Microsoft Excel. 

 
 Gambar Tampilan tab Formula 
 
Tabel Fungsi Menu dan Ikon Tab Formula. 
 

Tab Formula 

Kelompok Function Library 

Insert Function Memasukkan fungsi formula 

Autosum Melakukan penghitungan cepat 

Recently Used Memasukkan fungsi yang pernah digunakan 

Financial Memasukkan fungsi keuangan 

Logical Memasukkan fungsi logik 

Text Memasukkan fungsi teks 

Date & Time Memasukkan fungsi waktu 

Lookup & Reference Memasukkan fungsi lookup dan referensi 
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More Function Memasukkan fungsi lainnya 

Kelompok Defined Name 

Name Manager Membuat, mengubah, dan mencari nama yang digunakan 
dalam workbook 

Define Name Memberikan nama bagi sel 

Use in Formula Memilih nama yang digunakan pada workbook dan 
menggunakannya pada formula 

Create From Selection Membuat nama sel secara otomatis 

Kelompok Formula Auditing 

Trace Precedent Memperlihatkan panah pada sel lain yang memengaruhi nilaisel ini 

Trace Dependent Memperlihatkan panah pada sel lain yang dipengaruhi nilaisel ini 

Remove Arrows Menghilangkan panas yang dibuat oleh tracer 

Show Formulas Memperlihatkan formula setiap sel 

Error Checking Memeriksa formula yang salah 

Evaluate Formula Memperlihatkan kotak dialog evaluasi formula 

Watch Window Mengawasi nilai beberapa sel saat dilakukan perubahan 
pada lembar kerja 

Kelompok Calculation 

Calculation Menentukan kapan kalkulasi dilakukan 

Calculate Now Melakukan kalkuasi semua workbook sekarang 

Calculate Sheet Melakukan kalkulasi sheet sekarang 

 
e. Fungsi Menu dan Ikon tab Data 
Halaman pada ribbon ini berisi tombol-tombol untuk pengolahan data, seperti mengkoneksikan 
dengan file-file database lain, memfilter data, mengurutkan data (sorting) dan sebagainya. 

 
 Gambar Tampilan tab Data 
 
Tabel Fungsi Menu dan Ikon Tab Data. 

Tab Data 

Kelompok Get External Data 

From Access Memasukkan data dariMS Access 

From Web Memasukkan data dari web 

From Text Memasukkan data dari teks 

From Other Sources Memasukkan data dari sumber lain 

Existing Connection Memasukkan data dari sumber yang pernah digunakan 

Kelompok Connections 

Refresh All Menyegarkan kembali data yang diambil dari sumber 

Connection Memperlihatkan semua koneksi data pada workbook 

Properties Melakukan spesifikasi koneksi data pada workbook 

Edit Link Mengatur koneksi data dari file lain 

Kelompok Sort & Filter 

Sort A to Z Mengurutkan data dari yang terkecil ke terbesar 

Sort Z to A Mengurutkan data dari yang terbesar ke terkecil 

Sort Memunculkan kotak dialog pengurutan 
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Filter Melakukan penyaringan terhadap sel 

Clear Menghapus penyaringan pada sel 

Reapply Melakukan kembali penyaringan 

Advanced Melakukan penyaringan spesifik 

Kelompok Data Tools 

Text to Coloumn Memisahkan isi sel menjadi beberapa kolom 

Remove Duplicates Menghilangkan baris terduplikasi 

Data Validation Mencegah data yang tidak valid masuk ke sel 

Consolidation Menyatukan nilai beberapa range ke dalam satu range 

What-If Analysis Mencoba beberapa nilai pada formula 

Kelompok Outline 

Group Mengelompokkan baris sel sehingga mereka dapat 
memendekdan memanjang 

Ungroup Memisahkan sel yang mengelompok 

Subtotal Menghitung total beberapa baris data yang berhubungan 

 
f. Fungsi Menu dan Ikon tab Review 
Halaman pada ribbon ini berisi tombol-tombol untuk review (kaji ulang) naskah. Seperti mengecek 
ejaan, mengubah bahasa, translasi bahasa, menyematkan komentar, dan sebagainya. 

  
Gambar Tampilan tab Review 
 
Tabel Fungsi Menu dan Ikon Tab Review. 
 

Tab Review 

Kelompok Proofing 

Spelling Memeriksa ejaan teks 

Research Membuka panel penelitian referensi 

Thesaurus Saran kata yang sepadan 

Translate Menerjemahkan kata ke bahasa lain 

Kelompok Comments 

Comment Memasukkan komentar baru 

Delete Menghapus komentar 

Previous Memperlihatkan komentar sebelumnya 

Next Memperlihatkan komentar selanjutnya 

Show/Hide Comment Memperlihatkan atau menyembunyikan komentar 

Show All Comments Perlihatkan semua komentar 

Show Ink Memperlihatkan keterangan tinta pada lembar kerja 

Kelompok Changes 

Protect Sheet Melindungi lembar kerja 

Protect Workbook Melindungi buku kerja 

Share Workbook Berbagi buku kerja 

Protect and Share Workbook Melindungi dan berbagi buku kerja 

Allow Users to Edit Ranges Memperbolehkan pengguna mengubah data 

Track Changes Menelusuri perubahan yang terjadi pada dokumen 
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g. Fungsi Menu dan Ikon tab View 
Halaman pada ribbon ini berisi tombol-tombol untuk mengatur tampilan dari aplikasi, seperti 
menentukan bentuk tampilan halaman, pengaturan perbesaran (zoom) tampilan, membuatmacro, 
mengatur jendela-jendela yang ditampilkan, dan sebagainya. 

 
  

Gambar Tampilan tab View 
 

Tabel Fungsi Menu dan Ikon Tab View. 

Tab View 

Kelompok Workbook Views 

Normal Melihat dokumen secara normal 

Page Layout Melihat dokumen sesuai hasil cetak 

Page Break Preview Melihat tampilan dokumen beserta pemotongan setiaphalaman 

Custom Views Menyimpan seting tampilan dan hasil cetak 

Full Screen Melihat dokumen dalam mode layar penuh 

Kelompok Show/Hide 

Ruler, Gridlines, Message Bar, 
Formula Bar, Heading 

Memperlihatkan penggaris, garis kisi, batang pesan,batang 
formula, dan heading 

Kelompok Zoom 

Zoom Memperbesar tampilan 

100% Besar tampilan 100% 

Zoom to Selection Memperbesar tampilan sesuai bidang seleksi 

Kelompok Window 

New Window Membuka jendela baru yang memperlihatkan dokumenTersebut 

Arrange All Mengatur semua jendela program sejajar berdampingan 

Freeze Pane Membuat sebagian lembar kerja terlihat dan lainnya Menggulung 

Split Membagi jendela menjadi beberapa penel yang 
memperlihatkanlembar kerja Anda 

Hide Menyembunyikan jendela terseleksi 

Unhide Memunculkan jendela tersembunyi 

View Side by Side Memperlihatkan jendela berdampingan 

Synchronous Scrolling Membuat dua jendela menggulung bersamaan 

Reset Window Position Menset ulang posisi jendela berdampingan 

Save Wokspace Menyimpan pengaturan tampilan jendela sehinggadapat 
dibuka kembali dengan tampilan yang sama 

Switch Windows Berganti jendela yang aktif 

Kelompok Macros 

View Macros Memperlihatkan macro dokumen 

 
 
Kegiatan kompetensi 1 
1. Praktik mengaktifkan program aplikasi microsof excel 
2. Hidupkan computer atau laptop  

a. Aktifkan program microsof excel dengan berbagai cara berikut: 
b. Melalui start menu, yaitu dengan menglangkah berikut: start-program-all program-microsof 

excel 
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c. Meng-klik dua kali shortcut microsof excel pada desktop atau klik kemudian tekan enter 
d. Meng-klik kanan shortcut microsof excel pada desktop kemudian tekan open 
e. Meng-klik satu kali ikon microsof excel quick launch 
f. Identifikasi tampilan yang berada dalam microsof excel 

3. Cobalah menu menu yang ada pada microsof excel 
4. Jelaskan tentang cara mengukur tampilan (zoom) lembar kerja 
 
Uji kompetensi 1 
A. Pilihlah salah satu jawaban berikut dengan tepat 
1. Berikut  ini yang termasuk pengolah angka adalah … 
a. Microsoft Word   c.  Microsoft Powerpoint 
b. Paint    d.  Microsoft Exel 

 
2. Lembaran kerja pada Exel disebut … 
a. Worksheet   c.  Toolbar 
b. Workbook   d.  Status bar 

 
3. Bagian Exel yang berfungsi untuk menampilkan alamat sel yang sedang aktif … 
a. Bar Nama   c.  Bar Rumus 
b. Bar Judul   d.  Bar Status 

 
4. Tempat untuk mengetikkan rumus – rumus yang akan kita gunakan dalam Microsoft Exel 

disebut … 
a. Title Bar   c.  Address Bar 
b. Status Bar   d.  Formula Bar 

 
5. Ikon yang berfungsi untuk membuat lebar dan tinggi sel sesuai dengan tulisan yang diketik 

dalam sel disebut … 
a. Orientation  c.  Wrap Text 
b. Merge and Center  d.  Align Text Left 

 
6. Kumpulan dari beberapa sel disebut … 
a. Sel    c.  Baris 
b. Range   d.  Kolom 

 
7. Pertemuan antara baris dan kolom adalah … 
a. Sel    c.  Colomn 
b. Range   d.  Row 

 
8. Di bawah ini merupakan perintah – perintah dalam menu Insert kecuali … 
a. Sel    c.  chart 
b. picture   d.  clip art 

 
9. Workbook dalam Microsoft Office Exel merupakan kumpulan dari … 
a. Coloumn   c.  Sel 
b. Row    d.  Worksheet 

 
10. Untuk memperkecil ukuran tampilan jendeola Microsoft Office Exel adalah … 
a. Minimize   c.  Restore 
b.  Maximize   d.  Close 
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11. Berapa jumlah baris yang di Microsoft Excel... 
a.     1048575   c.     1048577 
b.     1048576   d.     1048578 
 
12. Ms. Excel adalah sebuah program under windows, artinya adalah .... 
a. Ms. Excel memiliki kemampuan dibawah Ms. Windows 
b. Ms. Excel sesuai untuk dijalankan pada program Ms. Windows 
c. Ms. Excel memiliki kemampuan yang sama dengan Ms. Windows 
d. masa/waktu pembuatan Ms. Excel lebih muda dari Ms. Windows 
 
13. Perintah untuk membuka file Excel adalah : 
a. New 
b. Open 
c. Close 
d. Exit 

 
14. Perintah untuk keluar dari Excel adalah 
a. Exit 
b. Close 
c. Open 
d. New 

 
15. File Excel 2007 yang sudah tersimpan akan mendapat akhiran .... 
a. XlsX  
b. DocX  
c. File    
d. Win 

 
16. Kita mencari atau menganti kata atau rangkaian kata dengan perintah…  
a. Find 
b. replace 
c. go to 
d. link 
 
17. Selain menggunakan mouse, keyboard juga dapat digunakan untuk menjalankan excel. Perintah 

berikut yang digunakan untuk menyimpan  adalah : 
a. Ctrl + S   
b. Alt + F4 
c. Ctrl + O   
d. Alt + F 
 
18. Salah satu cara untuk memilih seluruh data di lembar kerja adalah dengan menekan tombol…di 

keyboard.  
a. ctrl S 
b. ctrl P 
c. ctrl B 
d. ctrl A 

 
19. Perintah yang digunakan untuk menggandakan data adalah  
a. cut dan paste 
b. copy dan paste 
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c. copy dan cut 
d. select all dan copy 

 
20. Mengatur tanda decimal dan ribuan yang digunakan di lakukan di tab home, group ... 
a. number 
b. cells 
c. styles 
d. editing 

 
21. Selain dengan cara drag and drop. Memindahkan data dapat juga dilakukan dengan cara 

menjalankan perintah .... 
a. cut dan paste 
b. copy dan paste 
c. copy dan cut 
d. select all dan cut 

 
22. Mengatur tanda rupiah untuk data yang berupa uang dilakukan di kotak dialog .... 
a. number 
b. cells 
c. styles 
d. editing 

 
23. Perintah page setup dijalankan dari tab.... 
a. home 
b. insert 
c. view 
d. page layout 

 
24. Berikut ini yang tidak dapat digunakan untuk menjalankan excel adalah ... 
a. Shortcut excel di desktop 
b. Start menu 
c. File excel 
d. Dokumen word 

 
25. Bagian excel yang digunakan untuk menggerakkan lembaran kerja dalam arah horizontal adalah 

... 
a. scroll bar vertical 
b. scroll bar horizontal 
c. control lembaran kerja 
d. taks pane 

 
26. Perbesaran lembaran kerja diatur dengan menggunakan perintah .... 
a. custom view 
b. full screen 
c. zoom  
d. view sheets 

 
27. Perintah open dapat dijalankan dengan menekan tombol…dikeyboard. 
a. ctrl V 
b. ctrl O 
c. ctrl U 
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d. ctrl B 
 

28. Berikut ini tombol yang dapat digunakan untuk menggeser sel yang aktif adalah  
a. tombol enter 
b. tombol tab 
c. tombol arah 
d. semua benar 

 
29. Perintah untuk menggabungkan beberapa sel yang berdekatan dan data yang akan diformat 

rata tengah adalah .......... 
a. Align Left 
b.  Align Right 
c. Center 
d. Merge and Center 

 
30.  Fungsi untuk menambah jumlah digit desimal adalah ....... 
a. Decrease Decimal 
b. Comma Style 
c. Increase Decimal 
d. Percent Style 
 
B. Jawablah pertanyaan-pertanyaan di bawah ini dengan benar ! 

 
1. Microsoft Excel digunakan dibawah system operasi… 
2. Group perintah yang digunakan untuk membuat grafik adalah… 
3. Pertemuan antara baris dan kolom dalam Microsoft Excel disebut…. 
4. Gabubuangan dari beberapa sel dinamakan….. 
5. Open merupakan bagian dari menu…. 
6. Untuk Mencetak file dokumen digunakan tombol.............. 
7. Perintah Save, Undo dan Redo terdapat pada sebelah office button dinamakan ..... 
8. Page setup dan themes terdapat dalam tab…. 
9. Scroll bar tardiri dari …… dan ….. 
10. Bar yang menampilkan nama dokumen adalah… 
11. Split dan freeze pane terdapat pada tab….. dan group….. 
12. Untuk melindugi lembar kerja agar tidak diubah orang lain digunakan perintah… 
13. Untuk menambah baris pada lembar kerja agar tidak dapat diubah orang lain digunakan 

perintah.. 
14. Untuk mengeser lembar kerja ke arah atas dan bawah digunakan perintah…. 
15. Untuk menyaring perintah digunakan perintah.. 

 
Perhatikan gambar di bawah!(No 16, 17 dan 18) 

 
 

16. Untuk mengganti jenis huruf / Font kita bisa menggunakan bagian nomor …. 
17. Bagian yang berfungsi memberi Border pada tabel yang dibuat ditunjukkan dengan nomor …. 
18. Bagian no. 4 berfungsi ….menggabungkan sel 
19. Sebuah sel mempunyai alamat M16 maka sel tersebut berada pada ….kolom M baris 16 
20. Kita dapat menampilkan lembar kerja dalam layar penuh melalui perintah 

1 2 3 4 
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C. Jawablah Soal-soal berikut dengan jawaban yang tepat. 

 
1. Sebutkan tiga contoh program pengolah angka selain microsoft excel! 
2. Apakah yang dimaksud dengan ribbon? 
3. Apa yang dimasud dengan sel dan range! 
4. Sebutkan tombol-tombol yang ada di office button, kemudian jeslakan fungsinya (minimal tiga)! 
5. Tuliskan langkah-langkah untuk memulai dan mengakhiri microsoft excel 2007! 
6. Apa saja yang ditampilkan dalam control cendela… 
7. Tab apa saja yang terda pat pada Ribbon….. 
8. Apa fungsi Save As dan Save pada tombol office ….. 
9. Sebutkan keunggulan dari Microsoft excel 2007 … 
10. Bagaimana cara menambahkan tombol Toolbar Quick Access … 

 
Soal Remidi 
Jawablah pertanyaan-pertanyaan berikut dengan singkat dan jelas. 

1. Sebutkan kegunaan dari program Microsoft Excel! 
2. Sebutkan apa fungsi dari menu zoom! 
3. Perintah apa saja yang terdapat dalam office button? 
4.  Apa fungsi dari dari fungsi icon dan colour? 
5. Sebutkan Group yang terdapat pada tab home! 
6. Jelaskan bagaimana langkah-langkah membuat dan menyimpan. 
7. Jelaskan bagaimana cara membuat formula pada Microsoft Excel. 
8. Jelaskan cara menyalin (copy) dan menempel (paste) dalam Excel. 
9. Apa fungsi dari icon sort? 
10. Jelaskan fungsi dari formula bar! 
 

Portofolio 

Diskusikan dengan teman dan gurumu tentang tab-tab pada program pengolah angka microsof excel 

2007. Samakah jumlah tab pada program pengolah angka dengan jumlah tab yang ada dalam 

program pengolah kata? Jika tidaktab apa yang berbeda? 
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BAB 2 

MEMBUAT BUKU KERJA DAN MENGEDIT DATA 
 

Standar Kompetensi: 
Menggunakan perangkat lunak pengolah angka untuk menyajikan informasi 
 
Kompetensi Dasar: 
1.1 Menjelaskan fungsi menu dan ikon pada program pengolah kata 
1.2 Mengunakan  fungsi menu dan ikon pada program pengolah kata 
 
Kelas/semester: 
VIII/Genap 
 
Karakter Siswa yang Diharapkan 
Kreatif, Mandiri, Rasa Ingin Tahu 
 
Ringkasan Materi 
 
A. MENGENAL OPERASI DASAR EXCEL 

Dalam Excel, kita akan selalu bertemu dengan workbook dan worksheet. Kedua istilah 
tersebut akan selalu berhubungan dengan pekerjaan kita di Excel, Sebelum kita menggunakan Excel 
untuk pekerjaan tingkat yang lebih lanjut. Berikut ini akan dijelaskan beberapa tahapan 
pengoperasian dasar pada Excel 
 
Bekerja dengan Workbook 
Workbook merupakan file Excel yang didalamnya terdiri dari beberapa worksheet. Workbook bisa 
diibaratkan seperti sebuah buku yang terdiri dari lembar-lembar kertas yang disebut sebagai 
worksheet di Excel. 
 
Membuat Workbook Baru 

Untuk membuat sebuah file Excel atau workbook baru, langkahnya klik Start > All Programs 
> Microsoft Office > Microsoft Office Excel 2007. Pertama kali dibuka, otomatis membuat workbook 
baru. Setelah terbuka dan Anda ingin membuat workbook baru lagi, cukup tekan Ctrl N. 

 
Membuka Workbook yang Telah Dibuat 

Untuk membuka workbook yang sudah dibuat dan disimpan, berikut ini langkah-langkahnya: 
1. Klik Office Button 
2. Pilih file yang ada di Recent Documents untuk membuka file yang baru saja ditutup. 
Atau bisa juga dengan mengikuti langkah-langkah berikut: 
1. Klik Office Button > Open (Ctrl + O) 
2. Cari lokasi penyimpanan 
3. Pilih file (misalnya, latian1.xlsx) 
4. Klik Open 
 
Menyimpan  Workbook  

Setelah selesai melakukan pekerjaan menggunakan Excel atau ingin menyimpannya terlebih 
dahulu karena khawatir pekerjaan tersebut hilang karena hal-hal yang tidak diinginkan, kita dapat 
menyimpan workbook baru dengan cara sebagai berikut: 
1. Jika pertama kali menyimpan, tekan Ctrl + S 
2. Pilih lokasi penyimpanan 
3. Ketik nama file 
4. Pilih tipe file 
5. Klik Save 

Jika Anda sedang bekerja dan ingin menyimpan dengan nama file yang berbeda, caranya klik 
tombol Office > Save As > Excel Workbook. Selanjutknya sama seperti gambar diatas. 
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Menutup Workbook 
Untuk menutup workbook ang aktif, klik tanda Close (X) pada bagian kanan atas aplikasi 

Excel yang sekaligus akan menutup aplikasi tersebut juga atau klik Office Button > Close (tekan Ctrl + 
W) yang akan menutup workbooknya saja. 
Apabila workbook Excel belum kita simpan, ketika menutupnya akan mucul konfirmasi untuk 
klik Yes, apabila kita ingi menyimpan file kita; klik No, apabila kita tidak ingin menyimpannya; atau 
klik cancel, untuk membatalkan proses menutup workbook. 
 
B. MENGGERAKKAN PENUNJUK SEL (CELL POINTER) 

Cell Pointer berfungsi untuk penunjuk sel aktif. Yang dimaksud dengan sel aktif ialah sel yang 
akan dilakukan suatu operasi tertentu. Untuk menggerakan ponter dengan Mouse dapat dilakukan 
dengan meng-klik sel yang diinginkan. Untuk sel yang tidak kelihatan kita dapat menggunakan Scroll 
Bar untuk menggeser layar hingga sel yang dicari kelihatan lalu klik sel tersebut. Untuk kondisi 
tertentu kita lebih baik menggunakan keyboard. Berikut daftar tombol yang digunakan untuk 
menggerakan pointer dengan keyboard :  

Tombol  Fungsi  

← ↑ → ↓  Pindah satu sel ke kiri, atas, kanan atau bawah  

Tab  Pindah satu sel ke kanan  

Enter  Pindah satu sel ke bawah  

Shift + Tab  Pindah satu sel ke kiri  

Shift + Enter  Pindah satu sel ke atas  

Home  Pindah ke kolom A pada baris yang sedang dipilih  

Ctrl + Home  Pindah ke sel A1 pada lembar kerja yang aktif  

Ctrl + End  Pindah ke posisi sel terakhir yang sedang digunakan  

PgUp  Pindah satu layar ke atas  

PgDn  Pindah satu layar ke bawah  

Alt + PgUp  Pindah satu layar ke kiri  

Alt + PgDn  Pindah satu layar ke kanan  

Ctrl + PgUp  Pindah dari satu tab lembar kerja ke tab lembar berikutnya  

Ctrl + PgDn  Pindah dari satu tab lembar kerja ke tab lembar sebelumnya  

 
1.Jenis-jenis Pointer  

Berbeda dengan pointer dalam Microsoft Word, dalam Excel pointer selain berguna sebagai  
penunjuk  cell  atau  objek  juga  dapat  digunakan  untuk  operasi  lain. Berikut  beberapa  jenis 
pointer dalam Excel beserta fungsinya 
 
 

JENIS POINTER FUNGSI 

 
Memilih cell/range 

 

Memindahkan cell dan objek 

 

Memperlebar/mempersempit Kolom 

 

Memperlebar/mempersempit Baris 

 
Mengkopi cell dan fungsi didalamnya 

 
 
2.Mengatur Ukuran Sel 

Selain ukuran yang sudah disediakan oleh Excel, kita juga dapat melakukan pengaturan 
kembali sesuai dengan kebutuhan yang diinginkan . Berikut ini akan dijelaskan beberapa cara dalam 
melakukan pengaturan sel. 
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a.Menggunakan Mouse 
Cara praktis untuk mengatur ukuran sel adalah menggunakan mouse, yaitu dengan cara meletakkan 
mouse pointer pada sisi kanan batas kotak nama sel. Jika untuk melebarkan kolom. Sedangkan untuk 
mengatur tinggi sel dengan meletakkan mouse pointer pada sisi bawah batas kotak nama sel. 
Kemudian klik, tahan dan geser sesuai yang diinginkan, setelah mouse pointer berubah menjadi 
bentuk anak panah, 

 
 
b.Menggunakan Ukuran 
Menggunakan ukuran ini kita pakai karena mengatur ukuran sel dengan menggunakan mouse 
cenderung cukup sulit ketika kita ingin mengatur ukuran yang persisi (akurat), Apalagi kita ingin 
melakukan pengaturan sel dalam jumlah yang banyak, dimana semua sel tersebut harus mempunyai 
ukuran yang sama. Misalnya, kita akan mengubah ukuran kolom. Caranya sebagai berikut: 
1. Selesi kolom yang akan diubah ukurannya 
2. Pilih ribbon Home 
3. Klik Format 
4. Klik Column Width 
5. Ketik ukurannya 
6. Klik OK 

Untuk mengubah garis, caranya seperti di atas, Pada ikon Format, pilih Row Height 

  
 
c.Menyesuaikan ukuran Sel dengan Isinya 

Ukuran asli sel pada Excel kecil. Jadi, apabila kita memasukkan teks yang panjang tidak akan 
cukup untuk ukuran sel defaultnya. Misalnya, kita akan mengubah ukuran kolom secara otomatis. 
Caranya sebagai berikut: 
1. Seleksi kolom yang akan diubah 
2. Klik Format pada ribbon Home 
3. Klik Autofit Column Width 
 
C. MEMASUKKAN DAN MENGATUR DATA 

Data bisa berupa bahan-bahan keterangan, baik berupa teks maupun angka yang akan 
dimasukkan ke dalam sel. Hal yang harus diperhatikan, ketika memasukkan data ke dalam sel tidak 
boleh ada kesalahan. Sebab, apabila ada data yang salah yang masuk, Excel akan memberikan pesan 
kesalahan (error). Berikut ini beberapa penjelasan mengenai hal yang berhubungan dengan data 
Excel. 

Letakkan kursor antara kolom C 

dan D kemudian geser sesuai 

keinginan 

Klik row height kemudian 

akan muncul klom 

seperti gambar 

disamping 

Ketikan ukuran yang 

diingkan  
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1.Memasukkan dan menghapus Data 

Cara measukkn data ke dalam sel, cukup klik salah satu sel dilanjutkan dengan mengetik teks 
atau angka yang diinginkan. Setelah selesai, tekan Enter, sel yang aktif akan berpindah di bawah teks 
atau angka yang baru saja ditulis. Apabila kita tidak menginginkan perpindahan sel secara otomatis 
menuju ke bawah, tekan tombol tab. 

Jika data yang dimasukkan salah, untuk menghapusnya cukup klik sel yang akan dihapus lalu 
tekan tombol Delete di keyboard. Atau klik akanan sel lalu klik Delete. 

 
 
2.Mengatur Huruf 

Untuk mengatur huruf dapat dilakukan pada grup  Font  yang terdapat pada ribbon  Home. 
Caranya:  
1. Seleksi sel yang akan diubah hurufnya 
2. Pilih jenis huruf 
3. Pilih ukuran 
4. Pilih style (B = Bold, I = italic, U = Underline). 

Apabila kita ingin melakukan pengaturan lebih lanjut, klik tanda anak panah pada grup Font, 
lalu akan muncul kotak dialog Format Cells seperti berikut: 

 
 

Pada bagian underline, terdapat beberapa pilihan diantaranya: 

 None, tanpa garis bawah 

 Singge, garis bawah tunggal 

 Double, garis bawah ganda 

 Single Accounting, garis bawah tunggal pada penulisan akuntansi 

 Double Accounting, garis bawah ganda pada penulisan akuntansi 
Pada bagian effects terdapat beberapa pilihan, diantaranya: 

 Strikethrough, membuat coretan tunggal 

 Superscript, membuat karakter di atas dengan ukuran lebih kecil 

 Subscript, membuat karaktr di bawah dengan ukuran lebih kecil 
 
 
 

Pilih sel kemudian 

tuliskan angka 

Klik tombol di kiri 

bawah pada group 

font, maka akan 

muncul dialog box 
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3.Perataan (Allignment) 
Dalam meakukan perataan teks, kita dapat menggabungkan beberapa peataan sekaligus 

dengan batas maksimal 2 tombol yang aktif. 
Apabila kita ingin melakukan pengaturan, dapat mengklik tombol anak panah pada grup Allignment, 
lalu akan muncul halaman tab Allignment pada kotak dialog Format Cells. 

 
Lalu kita dapat melakukan pengaturan pada bagian Text Allignment, baik pada 
posisi Horizontal maupun vertical. Selain itu, pada tab Allignment juga terdapat beberapa 
pengaturan, diantanya: 
a. Bagian Indent, untuk mengatur ukurn identasi 
b. Bagian Text Control, untuk melakukan pengaturan teks, diantaranya terdiri: 

 Wrap Text, untuk menampung teks yang panjang ke dalam satu sel 

 Shrink to Fit, untuk memperkecil ukuran teks di dalam sel 

 Marge Cells, untuk menggabungkan beberapa sel 
c. Bagian Right-to-Left, untuk pengaturan arah teks (text direction) terdiri dari: 

 Left to Right, pengaturan dari kiri ke kanan 

 Right to Left, pengaturan dari kanan ke kiri 
d. bagian Orientation, digunakan untuk mengatur orientasi teks dengan memberikan nilai pada 
kotak Degrees. 
e.Mengatur Orientasi Teks, Presentasi teks digunakan untuk mengatur posisi suatu teks di dalam 
sel. Caranya: 

 Seleksi sel yang akan diubah orientasinya 

 Klik ikon Orientation 

 Pilih arah yang diinginkan 
 
4.Mengatur Wrap Text 

Ketika mengetik teks yang panjang ke dalam suatu sel, teks tersebut akan menerobos keluar 
dari sel. Kita dapat mengatasinya dengan melebarkan ukuran kolom atau memperkecil ukuran teks. 

Namun, apabila kita tidak menginginkan lebar dari kolom atau ukuran teks berubah, 
solusinya adalah menggunakan fasilitas ini. Wrap Text itu sendiri berfungsi untuk menampung teks 
yang panjang di dalam sel. Caranya: 
1. Pilih sel yang kita inginkan 
2. Klik ikon Wrap Text 

Klik tombol 

ini 
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5.Menggabungkan Beberapa sel 

Fasilitas Merge & Center digunakan untuk menggabungkan beberapa sel menjadi satu sel. 
Biasanya digunakan ketika data yang dimasukkan ke dalam sel melibatkan beberapa sel, yang 
mengharuskan untuk digabung. Tujuannya agar lebih baik tampilannya. Caranya: 
1. Pilih atau seleksi sel yang akan digabung 
2. Klik tombol Merge & Center di grup Allignment 

 
Keterangan: 

 Merge & Center, meggabungkan beberapa sel sekaligus menengahkan teks yang berada di 
dalamnya 

 Merge Across, menggabungkan sel yang terdiri dari beberapa kolom dan baris. Tetapi kolomnya 
saja yang aakan digabung sedangkan jumlah barisnya tetap. 

 Merge Cells, hanya menggabungkan beberapa sel menjadi satu sel tanpa menengahkan teks 

 Unmerge Cells, memecahkan kembali hasil penggabungan yang telah dilakukan. 
 
6.Mengolah Angka 

Program Excel dibuat untuk mengolah angka. Karenanya, akan banyak data berupa angka 
yang digunakan dan kita tidak boleh salah memasukkannya ke dalam sel. Hal tersebut terutama 
berkaitan dengan data yang sudah baku dan mengandung logika. 

Dalam pengaturan format angka, kita data lakukan pada grup Number (ribbon Home). 
Apabila settingan kompuer belum diubah, sema format penulisan angka, mata uang, tangga dan 
waktu akan mengikuti Negara Amerika. Misalnya, lambing mata uang menggunakan $ (dollar). 
Namun kita bisa mengatur sendiri. Untuk melakukannya, ikuti langkah-langkah sebagai berikut: 
1. Klik Start > Control panel > Date, Time, language and Regional Options 
2. Pilih bahasa Indonesia 
3. Klik OK 

Sekarang semua penulisan format angka, mata uang, tanggal dan waktu akan mengikuti 
Negara Indonesia. Hal ini berlaku pada semua program (tidak hanya apda Excel saja). 

Klik icon wrap text, setelah 

seleksi cel yang diinginkan 

Hasilnya 

text berada 

dalam satu 

sel 

Seleksi sel yang 

akan digabung, 

kemudian klik icon 

mail merge  
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Selanjutnya, untuk melakukan pengaturan format penulisan pada Excel, klik tombol 
dropdown Number Format, untuk membuka beberapa pengaturan format penulisan sesuai dengan 
fungsinya masing-masing. Caranya: 
1. Pilih sel yang akan kita isi dengan data kita 
2. Pilih Number Format pada grup Number 

 
Keterangan: 

 General, pengaturan umum (tanpa format khusus) 

 Number, pengaturan format angka yang akan ditentukan kemudian, seperti jumlah angka 
belakang koma dan penggunaan pemisah ribuan, misalnya 12.000,00. 

 Currency, memberikan pengaturan lambing mata uang suatu Negara 

 Accounting, penulisan mata uang dengan menggunakan aturan akuntansi. Mata uangnya berada 
rata kiri, sedangkan nilai angkanya berada rata kanan 

 Short Date, penulisan tanggal dengan format pendek. Misalnya, kita mengetik 27 Desember 
2008, maka hasilnya menjadi 27/12/2008 

 Long Date, penulisan tanggal dengan format panjang atau kealikan dari Short Date, Misalnya, 18 
September 2008 

 Time, digunakan untuk menuliskan jam, Misalnya, 07:50:35 

 Percentage, menampilkan angka dalam bentuk persentase. Misalnya, 0,1 akan ditampilkan 
menjadi 10% 

 Fraction, menuliskan angka decimal dalam bentuk pecahan. Misalnya, 0,75 akan dituls ¾ 

 Scientific, penulisan angka dengan gaya di bidang sains. Misalnya, 1450 alan ditulis 1,E+03 

 Text, penulisan semua data ke dalam sel akan dianggap sebagai teks meskipun itu angka. Salah 
satu keguanannya adalah membiarkan angka nol (0) yang ditulis di depan angka, misalnya pada 
penulisan nomor telepon. Sebab, jika tidak di atur dengan format text, maka Excel secara 
otomatis akan menghilangkan angka nol (0) tersebut. 

 
Untuk melakukan pengaturan lebih jauh, caranya klik tobol anak apanah pada 

grup Number, sehingga akan muncul kotak dialog Format Cell (tab Number). 
Di sini ada dua format penulsian tambahan yang tidak ditemukan pada menu drop-down 

Number Format, yaitu Special dan Custom. 
Format Special digunakan untuk mengatur penulisan tipe format tertentu seperti kode pos 

dan nomor telepon sesuai dengan Negara yang dipilih. Jika settingan lokasi Negara yang digunakan 
adalah Indonesia, secara default tidak ada pilihan pada tipe format penulisan. 

Sedangkan Custom, digunakan untuk melakukan pegaturan format sediri. Pada bagian ini, 
akan ditampilkan beberapa pilihan pola format penulisan. 

Selain dapat menentukan sendiri pola yang diinginkan dengan mengetikkan pada 
kolom Type, kita pun dapat langsung memilih beberapa pola yang sudah disediakan. Antara lain: 

 0, digunakan untuk menampilkan angka dibelakang koma. Misalnya, dengan pola 0.00. maka 
pernulisan 1500 akan menjadi 1500,00. 

Klik tanda panah 

dalam group number 

maka akanmuncul 

dialog box seperti di 

bawahnya 
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 #, digunakan untuk menampilkan angka dengan pengaturan tertentu. Misalnya, dengan pola 
#.##0.00. maka penulisan 1500 akan menjadi 1.500,00. 

 E, menampilkan pecahan dengan bentuk eksponen (10 pangkat n). Misalnya Anda mengetik 1234 
dengan pola 0,00E+00 maka akan ditampilkan menjadi 1,23E+03 

 Rp, digunakan untuk menampilkan angka dengan symbol mata uang Rupiah, Misalnya, Anda 
mengetik 50000 dengan pola Rp#.##0_):(Rp#.##0), maka akan menjadi Rp50.000. 

 d, m, y, digunakan untuk menuliskan hari, bulan dan tahun, Misalnya, Anda menulis 16/05/2009 
dengan pola dd-mm.yy, maka akan ditampilkan menjadi 16/05/09 

 h, m, s, AM, PM, digunakan untuk menuliskan jam, menit dan detik dalam pengaturan AM atau 
PM. Misalnya, penulisan 10:10:10 dengan pola h:mm:ss AM/PM, maka akan menjadi 10:10:10 
AM 

 
7.Mengatur Border 

Dalam tampilan default Excel, garis yang muncul dalam worksheet berfungsi sebagai garis 
Bantu saja. Untuk memberikan garis yang sebenarnya kita harus memberikan border. 

Menu untuk membuat border tersebut masih berada pada kotak dialog Format 
Cells (tab Border). Di sini, kita dapat mengatur jenis garis, warna, serta pengaturan posisi dari border 
tersebut apda sel 
Untuk melakukannya, ikuti langkah-langkah berikut: 
1. Seleksi sel yang akan diberi border 
2. Klik tanda panah Format Cells: Allignmen 
3. Klik tab Border 
4. Pilih style 
5. Klik border yang diinginkan. Misalnya, diagonal 
6. Klik OK 

 
 
8.Mengatur Warna 

Untuk menambahkan keindahan, kita bisa mewarnai sel. Caranya sangat mudah, yaitu: 
1. Seleksi sel yang akan diberi warna 
2. Klik ikon Fill Color 
3. Pilih warna yang Anda inginkan 

 
 
 

Dialog box untuk 

pengaturan border 

Klik OK setelah 

memilih warna 

untuk sel yang aktif 
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9.Mengatur baris dan Kolom 
Kita akan membutuhkan pengaturan tersendiri sel yang ada, apabila data yang masuk 

semakin banyak agar dapat dikelola dengan baik. Semua pengaturan baris dan kolom berada pada 
grup Cells ribbon Home. 
 
a.Menyembunyikan Baris dan Kolom 

Fasilitas untuk menyembunyikan baris dan kolom tidak akan menghilangkan data yang 
disembuyikan tersebut. Cara untuk menyembunyikan sebagai berikut: 
1. Seleksi baris atau kolom yang ingin disembunyikan 
2. Klik kanan lalu pilih Hide 

Untuk menampilkan kembali baris/kolom yang telah disembunyikan, seleksi pada kotak 
nama baris/kolom yang mengapit baris/kolom yang telah disembunyikan sebelumnya. Kemudian klik 
kanan mouse, lalu pilih Unhide pada menu yang muncul. 

 
 
b.Membekukan Baris dan Kolom 

Selain menyembunyikan, kita juga bisa membekukan kolom maupun baris. Hal ini dilakukan 
bila jumlah kolom maupun baris terlalu panjang. Jika kita geser, kolom maupun baris pertama akan 
disembunyikan. Padahal, kita membutuhkannya sebagai acuan. Untuk itu., kita bisa 
membekukannya dengan cara sebegai berikut: 

 

 
Misal, kita akan membekukan baris judul apabila kita memiliki daftar data yang panjang ke bawah. 
1. Pilih sel A5, karena kita akan membekukan baris judul yang terletak ditasnya 
2. Klik View 
3. Klik Freeze Panes 
4. Klik Freeze Panes 

Keterangan: 

 Freeze Panes, untuk membekukan baris atau kolom 

 Freeze Top Row, untuk membekukan baris pertama saja 

 Freeze First Columns, untuk membekukan kolom pertama saja 
5. Gulung scroll bar ke bawah. Judul akan berada pada posisi semula sedangkan daftar dibawahnya 

yaitu nomor 1 – 3 telah di gulung (disembunyikan). 
6. Untuk mengembalikan baris atau kolom yang telah dibekukan, klik tombol Unfreeze Panes pada 

menu Freeze Panes 
 

 
D.MENGOLAH DATA LEBIH LANJUT 

Setelah kita membahas dasar-dasar untuk memasukkan data serta beberapa pengaturan 
data yang bisa dilakukan, selanjutnya kita akan membahas tentang pengolahan datanya. 

Pilihan menu hide dan 

unhide untuk 

menyembunyikan dan 

menampilkan kembali 

baris atau kolom 

Menu freeze 

panes pada tab 

view group 

window 

Page 31 of 72



 
1.Mengubah Isi Sel 

Apabila kita ingin seara cepat mengubah isi dari suatu sel atau menyisipkan beberapa data di 
dalamnya, klik sel yang akan diubah isinya, lalu tekan F2 pada keyboard. Kursor akan muncul di 
dalam sel tersebut, selanjutnya kita tinggal mengetikkan teks/angka yang diinginkan atau bahkan 
dihapus, dengan menggunakan anak panah pada keyboard sebagai navigasi. Setelah selesai 
melakukan perubahan, tekan tombol Enter . 
Selain itu, Anda bisa melakukan cara sebagai berikut: 
1. Klik sel yang akan diubah 
2. Ubah isi sel pada kotak formula 

 
 
2.Membatalkan Pekerjaan 

Apabila kita sedang melakukan pekerjaan ternyata ada kesalahan dan ingin membatalkan 
perintah yang telah dilakukan sebelumnya, cukup dengan menekan tombol Undo (tekan Ctrl + Z). 
Untuk mengulang kembali beberapa tindakan yang sudah di-Undo, cukup tekan 
tombol Redo (tekan Ctrl + Y). Tombol perintah tersebut dapat ditemukan pada Quick Access Toolbar 

Kita dapat juga melihat daftar undo dan juga Redo yang telah kita lakukan. Klik tanda panah 
yang berada di samping Udo dan Redo. Untuk menggunakannya. Kita dapat langsung memilihnya. 

 
 
3.Memindahkan Data 

Cara memindahkan data, baik berupa angka atau teks, baik untuk disalin agar tidak perlu 
membuat lagi karena datanya sama atau mungkin hanya sekedar pemindahan ke tempat lain, dapat 
kita lakukan melalui grup Clipboard pada ribbon Home. 
Copy, Cut dan Paste 

Cara melakukan copy, cut dan paste cukup sederhana, yaitu: 
a. Copy (tekan Ctrl + C) digunakan untuk proses penyalinan data dengan jumlah tertentu dimana 

data aslinya masih tetap ada. Data tersebut dapat berupa teks, angka, gambar dan lain 
sebagainya 

b. Cut (tekan Ctrl + X) digunakan untuk memindahkan data dar satu tempat ke tempat yang lain 
c. Dari data-data yang telah dilakukan perintah Copy dan Cut, akan disimpan pada wadah yang 

namanya Clipboard, Untuk melakukan proses pengeluaran data dari Clipboard, dapat dilakukan 
dengan Paste (tekan Ctrl + V) 

 
4.Copy, Cut dan Paste Terhadap Isi Sel 

Apabila kita hanya ingin men-copy atau meng-cut sebagian data yang ada di dalam sel, 
caranya sebagai berikut: 
a. Klik dua kali mouse pada sel yang ingin di-copy atau di-Cut tersebut 
b. Seleksi teks yang akan di-Copy atau Cut 
c. Klik kanan lalu pilih perintah yang Anda inginkan 
d. Paste (Ctrl + V) pada sel lain 

 

Kotak 

formula 

Menu undo 

dan redo  
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5.Paste Special 
Penggunaan Paste Special tergantung dari isi data yang akan kita paste-kan. Misalnya, kita 

hanya membutuhkan format sel yang disalin sama dengan sel yang kita inginkan. Caranya: 
a. Klik kanan sel yang akan disalin formatnya 
b. Klik ikon Copy pada Clipboard 
c. Seleksi sel yang akan disamakan formatnya 
d. Klik kanan lalu klik Paste Special 
e. Klik Format 
f. Klik OK 

 
Beberapa pilihan yang terdapat pada kotak dialog Paste Special, antara lain: 

a. Pada bagian paste, terdiri dari: 

 All, paste dengan mengikutsertakan nilai dan formatnya 

 Formulas, paste formulanya saja 

 Values, paste nilainya saja 

 Formats, paste formatnya saja 

 Comments, paste komentarnya saja (jika diberi komentar) 

 Validation, paste validasi data sel 

 All using Source Theme, paste semua isi menggunakan format pokok 

 Column Widht, paste lebar kolom 

 Formula and Number Formats, paste formula dan format angka 

 Values and Nmber Formats, paste nilai dan format angka 
b. Pada bagian Operation, terdiri dari: 

 None, tidak ada pengaturan 

 Add, penambahan 

 Substract, pengurangan 

 Multiply, perkalian 

 Divide, pembagian 
c. Skip Blanks, tidak akan mengikutsertakan sel yang kosong (tidak berisi data) saat di paste 
d. Transpose, untuk mengubah posisi baris menjadi kolom atau sebaliknya 
e. Paste Link, untuk melakukan paste sebagai link 
 
6.Menggunakan Format Painter 
Jika memang Anda ingin menyalin formatnya saja, cara yang paling cepat adalah menggunakan 
format pointer. Isi dari sel tidak akan ikut disalin. Untuk melakukannya, ikuti langkah sebagai berikut: 
1. Seleksi data yang ingin di salin 
2. Klik tombol Format Pointer yang terdapat pada grup Clipboard (ribbon Home) 
3. Klik di sel lain 

dialog box paste 

special untuk 

memilih salinan 

yang diingkan 

Page 33 of 72



 
 
Kegiatan kompetensi 1 
 
Buatlah buku kerja dengan ketentuan sebagai berikut 
1. Buatlah nomor urut dengan cara mengurutkan data  
2. Tuliskan kelas dengan memasukkan data sekaligus 
3. Tuliskan tanggal lahir dengan format tanggal 
4. Gunakan format accounting dengan satuan Rp pada tabungan   
 
 

 
 
 
Uji Kompetensi 2 
 
A. Pilihlah salah satu jawaban soal berikut dengan tepat 
 
1. Definisi dari sel adalah ..... 

a. bagian yang ditampilkan lebih terang. 
b. Pertemuan antara baris dan kolom 
c. Petunjuk (user) di dalam worksheet 
d. Bagian dari worksheet 

2. Pengertia dari Sel A1 adalah ......... 
a. pertemuan antara baris A dengan kolom 1 
b. pertemuan antara kolom A dengan kolom 1 
c. pertemuan antara kolom A dengan baris 1 
d. perpotongan antara sel A1 

3. Sekumpulan Sel tertentu yang berada pada daerah yang sama adalah ........... 
a. Sel 
b. Sel dan Range 
c. Range 
d. Field 

4. Untuk Pindah dari satu tab lembar kerja ke tab lembar kerja lainnya adalah dengan cara 
menekan .............. 
a. Tab 
b. crtl+ pg dn 

Menu clipboard 

untuk mempercepat 

proses paste  
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c. Enter 
d. Shift + Enter 

5. Untuk memperbaiki kesalahan dengan cara melalui sel aktif yaitu .......... 
a. F1 
b. F2 
c. F3 
d. F4 

6. Perintah untuk lebar kolom agar sesuai dengan data yang ada dengan menggunakan Format, 
Colmn lalu pilih ......... 
a. Width 
b. Auto Fit Selection 
c. Standard Widht 
d. Row Height 

7. Perintah untuk memformat angka dengan menggunakan menu format cell lalu pilih ..... 
a. Number 
b. Font 
c. Aligment 
d. Border 

8. Perintah untuk memformar mata uang dengan menggunakan tab number pada kagori, lalu pilih 
...... 
a. General 
b. Date 
c. Currency 
d. Percentage 

9. Perintah untuk memformat rata kiri adalah ...... 
a. Align Left 
b. Align Right 
c. Center 
d. Merge and Center 

10. Perintah untuk menggabungkan beberapa sel yang berdekatan dan data yang akan diformat 
rata tengah adalah .......... 
a. Align Left 
b. Align Right 
c. Center 
d. Merge and Center 

11. Fungsi untuk menambah jumlah digit desimal adalah ........ 
a. Decrease Decimal 
b. Comma Style 
c. Increase Decimal 
d. Percent Style 

12. Tombol untuk memindahkan lembar kerja dari sheet 1 ke sheet 2 tekan tombol ........ 
a. Ctrl + PgDn 
b. Shift + PgDn 
c. Ctrl + PgUp 
d. Alt + PgUp 

13. Untuk menyisipkan Sheet setelah memilih menu Insert maka pilih sub menu .... 
a. Work Sheet 
b. Delet Sheet 
c. Rename 
d. Move or Copy Sheet 

14. Untuk nama Tab sheet pada menu format pilih sub menu ..... 
a. Sheet, Rename 
b. Sheet Unhide 
c. Sheet Hide 
d. Sheet Beckground 

15. Perintah untuk menghapus lembar kerja pilih menu ....... 
a. sheet-Edit 
b. sheet-insert 
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c. sheet-delete 
d. sheet-hide 

Untuk no 16 dan 17 Perhatikan gambar berikut……….. 

  A B C D 

1 DATA SISWA MTs  MANDIRI   

2         

3 
No Kelas 

Jumlah 
Siswa   

4 1 7 121   

7 Jumlah     

16. Kata  “NO” dan  “JUMLAH SISWA”   terletak pada sel … 
a. A1 dan C1 
b. B3 dan C3 
c. A3 dan C3 
d. A4 dan C4 

17. Daerah yang diblok atau disorot pada tabel di atas adalah sel .... 
a.  A1 : C1   
b.  B4 : B6  
c.  A3 : C4 
d.  C4 : C6 

18. Tombol untuk menghapus isi sebuah cell… 
a. backspace  
b. Delete 
c. esc  
d. Break 

19. Untuk pengaturan paragrap rata kanan maka meng-klik .... 

 a.    c.     

        b.    d.  
20. Perintah untuk menduplikasi teks adalah icon …. 
 a. Copy & Paste   c. Close 
 b. Cut & Paste  d. Move 
21. Untuk penyimpanan dokumen yang telah ada kemudian akan disimpan kedalam bentuk file lain 

maka meng-klik .... 
 a. Open   c. Save 
 b. Save As Webpage d. Save As 
 

22.   Ikon disamping dinamakan .... 
 a. Open   c. Copy    
 b. Paste   d. Format Painter  
23. Untuk mengubah tinggi baris menjadi tinggi tertentu, melalui baris menu adalah  …. 

a. Klik Format> Cells> Border 
b. Klik Format> Cells> Number 
c. Klik Format> Column> Width 
d. Klik Format> Row> Height 

24. Untuk menghapus satu kolom, perintahnya adalah.. 
a. klik Edit> Delete> Entire Row 
b. klik Edit> Delete> Entire Column 
c. klik Edit> Delete> Cells 
d. klik Edit> Delete sheet 

25. Untuk memberi warna pada huruf atau kalimat adalah dengan meng-klik ikon .... 
 a.      c. 
 
  b.      d.  
 
26. Pada bagian Margin, yang dimaksud Top adalah….  
 a. batas atas  c. batas kiri 
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 b. batas bawah  d. batas kanan 
27. Untuk melihat kembali tampilan pada lembar kerja sebelum dicetak adalah dengan klik ... 
 a. Print  c. New 
 b. Copy  d. Print Preview 
28. Ukuran kertas dengan Orientation :Portrait akan menghasilkan bentuk …. 
 a. miring  c. horizontal 
 b. tetap  d. vertical 
29. Dalam pengetikan dokumen kita dapat mencetak dokumen tersebut dengan berbagai ukuran 

kertas. Ukuran kertas kuarto sama dengan ukuran yang ada pada komputer adalah .... 
a. legal   c. letter 
b. folio   d. A4 

30. Untuk menghapus satu baris, perintahnya adalah.. 
a. klik Edit> Delete> Entire Row 
b. klik Edit> Delete> Entire Column 
c. klik Edit> Delete> Cells 
d. klik Edit> Delete sheet 

 
B. Lengkapilah Soal Berikut Dengan Jawaban Yang Tepat 
1. Tab  untuk memberikan garis bingkai atau border adalah.. 
2. Group perintah yang digunakan untuk membuat grafik adalah.. 
3. Tombol shotcut untuk mencetak dokumen adalah.. 
4. PgUp digunakan untuk memindahkan penunjukan sel… 
5. Ctrl + PgDn digunakan untuk…  
6. Secara default apabila kita memasukkan ada angka maka akan mengikuti perataan.. 
7. Tabulasi dalam formal cells terdiri atas… tab. 
8. General, number, dan currency pada kotak dialog format cels berada pada tabulasi… 
9. Shift+enter digunakan untuk memmindahkan penunjuk sel… 
10. Untuk memasukkan data, apabila selesai mengetik data, maka selanjutnya adalah.. 
11. Paste special + value perintah ini digunakan untuk 
12. Perintah shortcut untuk cut adalah… 
13. Perintah yang digunakan Apabila kita sedang melakukan pekerjaan ternyata ada kesalahan dan 

ingin membatalkan perintah yang telah dilakukan sebelumnya adalah tombol…. 
14. Perintah yang digunakan untuk merubah isi sel  dengan menekan tombol …. pada keyboard 
15. Perintah untuk membekukan baris atau kolom adalah   
16. Fasilitas untuk menyembunyikan/memuculkan kembali data baris dan kolom disebut… 
17. Penulisan mata uang dengan menggunakan aturan akuntansi mengunakan fasilitas…  
18. Fasilitas  yang digunakan untuk menggabungkan beberapa sel menjadi satu sel….. 
19. Fasilitas yang  berfungsi untuk menampung teks yang panjang di dalam sel….  
20. Fasilitas untuk membuat karakter di atas dengan ukuran lebih kecil…  

 
C. Jawablah soal-soal berikut dengan singkat dan tepat 
1. Jelaskan bagaimana langkah-langkah menbuat buku kerja 

2. Jelaskan tentang cara memmindahkan set pointer ke kiri, kekanan, atas, atau bawah 

3. Jelaskan bagaimana cara memasukkan data kedalam lembar kerja excel 

4. Jelaskan bagaimana cara memberikan tanda rupiah(Rp) angka pada excel 

5. Jelaskan bagaimana langkah-langkah merubah ukuran sel 

6. Jelaskan bagaimana langkah-langkah mengabungkan sel 

7. Bagaimana langkah-langkah memindah lembar kerja 

8. Jelaskan bagaimana cara memindahkan data 

9. Bagimana cara menyimpan buku kerja dengan file yang baru 

10. Jelaskan bagaimana menyimpan buku kerja dengan kata sandi  

Soal Remidi 
1. Apa yang kalian ketahui tentang workbook dalam excel 
2. Apa yang kelian ketahui tentag worksheet dalam excel 
3. Jelaskan bagaimana meyimpan buku kerja/workbook 
4. Bagaicara membuat rata kanan tulisan pada sel 
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5. Apa fungsi baris rumus 
6. Bagaimana cara memberikan warna pada sel 
7. Bagaimana cara mebrikan border pada sel 
8. Bagaimana mebuat format penulisan tanggal 
9. Bagaimana cara membatalkan perintah dalam excel 
10. Jelaskan tentang save dan save as 

 
Portofolio 
 
Buatlah buku kerja dengan ketentuan sebagai berikut 
1. Data merupakan data siswa kalian 
2. Buat nomer urut dengan cara mengurutkan data 
3. Tulis keasl dengan memasukkan data sekaligus 
4. Tulis tanggal lahir dengan format tanggal 
5. Tulis waktu berangkat sekolah dengan format jam 
6. Tulis uang saku dengan format accounting Rp 
7. Simpan dengan nama file datakelasku.xlsx di folder yang kamu inginkan 
8. Format tabelnya adalah sebagai berikut ini 

 
 

 
 
 

ULANGAN BLOK TENGAH SEMESTER 
 
A.pilihkah salah satu jawaban berikut yang tepat 
1. Ms. Excel adalah sebuah program under windows, artinya adalah .... 

a. Ms. Excel memiliki kemampuan dibawah Ms. Windows 
b. Ms. Excel sesuai untuk dijalankan pada program Ms. Windows 
c. Ms. Excel memiliki kemampuan yang sama dengan Ms. Windows 
d. masa/waktu pembuatan Ms. Excel lebih muda dari Ms. Windows 

2. Perintah untuk membuka file Excel adalah : 
a. New 
b. Open 
c. Close 
d. Exit 

3. Layar lembar kerja Excel dapat diperbesar /diperkecil sesuai ukuran yang diminta dengan meng-
klik icon … 

 a.    c.  

 b.   d.  
4. Didalam jendela Excel terdapat tampilan: sheet1, sheet2,sheet3. Bagian tersbut dinamakan …. 

a. Tittle bar c. Lembar sheet 
b.    Toolbar d. Menu Bar 

5. Orientasi yang digunakan untuk memilih portrait adalah… 
a. Melintang  c. membujur 
b. Column   d. Cells 

6. Berfungsi untuk mencetak lembar kerja ke printer yaitu… 
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a. Print   c. page break preview 
b. Print preview  d. zoom 

7. Untuk mengakhiri print preview dapat dilakukan dengan perintah… 
a. Next   c. exit 
b. Close   d. quit 

8. Microsoft excel adalah program yang ditujukan untuk pengolahan… 
a. Angka  c. gambar 
b. Kata  d. data dan gamb 

9. Tombol untuk memindahkan lembar kerja dari sheet 1 ke sheet 2 tekan tombol ........ 
a. Ctrl + PgDn 
b. Shift + PgDn 
c. Ctrl + PgUp 
d. Alt + PgUp 

10. Beberapa bentuk jenis data HH:MM:SS termasuk pada bentuk .......... 
a. Teks 
b. Waktu 
c. Tanggal 
d. Angka 

11. Perintah untuk menggabungkan beberapa sel yang berdekatan dan data yang akan diformat rata 
tengah adalah .......... 
a. Align Left 
b. Align Right 
c. Center 
d. Merge and Center 

12.  Fungsi untuk menambah jumlah digit desimal adalah ........ 
a. Decrease Decimal 
b. Comma Style 
c. Increase Decimal 
d. Percent Style 

13. Untuk menyisipkan Sheet setelah memilih tab home  maka pilih group .... 
a. cells 
b. editing 
c. Alignment 
d. Style 

14. Salah satu cara untuk memilih seluruh data di lembar kerja adalah dengan menekan tombol…di 
keyboard.  
a. ctrl S 
b. ctrl P 
c. ctrl B 
d. ctrl A 

15. Perintah yang digunakan untuk menggandakan data adalah  
a. cut dan paste 
b. copy dan paste 
c. copy dan cut 
d. select all dan copy 

16. Mengatur tanda decimal dan ribuan yang digunakan di lakukan di tab home, group ... 
a. number 
b. cells 
c. styles 
d. editing 

17. Selain dengan cara drag and drop. Memindahkan data dapat juga dilakukan dengan cara 
menjalankan perintah .... 
a. cut dan paste 
b. copy dan paste 
c. copy dan cut 
d. select all dan cut 

18. Menambahkan tanda pemisah ribuan ke data yang di lembaran kerja dilakukan di kotak dialog .... 
a. number 
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b. cells 
c. styles 
d. editing 

19. Mengatur tanda rupiah untuk data yang berupa uang dilakukan di kotak dialog .... 
a. number 
b. cells 
c. styles 
d. editing 

20. Perintah page setup dijalankan dari tab.... 
a. home 
b. insert 
c. view 
d. page layout 

21. Perintah untuk menyimpan lembar kerja excel dengan menekan tombol adalah ... 
a. Ctrl S 
b. Ctrl N 
c. Ctrl V 
d. Ctrl A 

22. Berikut ini yang tidak dapat digunakan untuk menjalankan excel adalah ... 
a. Shortcut excel di desktop 
b. Start menu 
c. File excel 
d. Dokumen word 

23. Bagian excel yang digunakan untuk menggerakkan lembaran kerja dalam arah horizontal adalah 
... 
a. scroll bar vertical 
b. scroll bar horizontal 
c. control lembaran kerja 
d. taks pane 

24. Perbesaran lembaran kerja diatur dengan menggunakan perintah .... 
a. custom view 
b. full screen 
c. zoom  
d. view sheets 

25. Perintah open dapat dijalankan dengan menekan tombol…dikeyboard. 
a. ctrl V 
b. ctrl O 
c. ctrl U 
d. ctrl B 

26. Berikut ini tombol yang dapat digunakan untuk menggeser sel yang aktif adalah  
a. tombol enter 
b. tombol tab 
c. tombol arah 
d. semua benar 

27. Bagian Ms. Excel yang menyediakan menu pilihan dengan tampilan berupa icon-icon adalah .... 
a. ribon 
b. romblo office 
c. title  
d. fuction 

28. Pada Microsoft Excel, sekumpulan sel yang saling bersebelahan disebut…. 
a. pointer 
b. range 
c. cell 
d. Data 

29. Pada lembar kerja Microsoft Excel, yang menunjukkan kolom pada cell B29 adalah…. 
a. B 
b. B29 
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c. 29 
d. B2 

30. Perintah untuk menyisipkan baris yang benar adalah  
a. klik Insert> Coloum 
b. klik Insert> Row 
c. klik Format> Column > Width 
d. klik Format> Row> Height 

 
B.Jawablah soal-soal berikut dengan singkat dan tepat 
1. Sebutkan beberapa cara mengaktifkan excel   

2. Sebutkan beberapa pengolah angka yang kamau ketahui 

3. Sebutkan tab yang ada pada ribbon 

4. Jelaskan langkah-langkah mengganti nama sheet pada excel 

5. Jelaskan fungsi icon yang terdapat pada group font tab home 

6. Jelaskan fungsi icon yang terdapat pada group cels tab home 

7. Apa yang kamu ketahui tentang wrap text? 

8. Apa yang kamu ketahui tentag freezspene 

9. Jelaskan bagaimana cara mengatur lebar kolom dengan mengunakan mouse 

10. Jelakan cara menyalin fungsi dengan mengunakan paste special  

                           

 
BAB 3 

MENGUNAKAN RUMUS DAN FUNGSI 
 

Standar Kompetensi: 
Menggunakan perangkat lunak pengolah angka untuk menyajikan informasi 
 
Kompetensi Dasar: 
Membuat dokumen pengolah angka sederhana 
 
Kelas/semester: 
VIII/Genap 
 
Karakter Siswa yang Diharapkan 
Jujur, Disiplin,  Kerja Keras, Kreatif, Mandiri, Rasa Ingin Tahu 
 
Ringkasan Materi 
 
A.BEKERJA DENGAN RUMUS DAN FUNGSI 

1.Menggunakan Rumus (Formula) 

Rumus merupakan bagian terpenting dari Program Microsoft Excel , karena setiap tabel dan 
dokumen yang kita ketik akan selalu berhubungan dengan rumus dan fungsi. Operator matematika 
yang akan sering digunakan dalam rumus adalah ; 

Operator Keterangan 

= (sama dengan) Digunakan paling depan sebelum 
melakukan perhitungan 

^ (perpangkatan) Simbol untuk melakukan perpangkatan 

/ (pembagian) Simbol untuk melakukan pembagian 

* (perkalian) Simbol untuk melakukan perkalian 

+ (penjumlahan) Simbol untuk melakukan penjumlahan 

- (pengurangan) Simbol untuk melakukan pengurangan 

; (titik koma) Simbol untuk pembatas antar rumus 

, (koma) Simbol untuk pembatas antar rumus 
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( (kurung buka) Simbol awal dari sekelompok rumus 

) (kurung tutup) Simbol akhir dari sekelompok rumus 

 

Proses perhitungan akan dilakukan sesuai dengan derajat urutan dari operator ini, dimulai 
dari pangkat (^), kali (*), atau bagi (/), tambah (+) atau kurang (-). 

 

Kegiatan kompetensi 1 : 

Ketiklah contoh berikut dalam excel anda dan hitunglah total tersebut dengan menggunakan fungsi 
penjumlahan. ( total = Harga x Jumlah).  Setelah selesai silakan simpan dengan nama file : 
latihan1.xls. 

 

 

 

 

 

2.Acuan/Alamat 

a. Alamat Relatif : merupakan alamat yang jika dituliskan kedalam bentuk rumus atau fungsi akan 
berubah jika dicopy ke cell lain. 
Contoh : cell berisi formula A5*6 ,B3 dicopy ke C5 formula pada C5 berubah menjadi B8*6 

b. Alamat Semi Absolut : merupakan alamat yang dituliskan dengan tanda $ didepan baris atau 
kolomsehingga nilai tidak akan berubah. 
Contoh : Cell B1 berisi formula $A1*7,B1 dicopy kan ke D5 formula pada D5 menjadi $A5*7 

c. Alamat Absolut : merupakan alamat yang dituliskan dengan tanda $ didepan baris dan 
kolom.tekan tombol F4 untuk menghasilkan alamat absolut pada formula bar. Contoh : cell B1 berisi 
formula $A$1&5,B1 dicopy kan ke C3 formula pada C3 menjadi $A$1*5 

2.Menggunakan Fungsi 

Fungsi sebenarnya adalah rumus yang sudah disediakan oleh Microsoft Excel, yang akan 
membantu dalam proses perhitungan. kita tinggal memanfaatkan sesuai dengan kebutuhan. Pada 
umumnya penulisan fungsi harus dilengkapi dengan argumen, baik berupa angka, label, rumus, 
alamat sel atau range. Argumen ini harus ditulis dengan diapit tanda kurung (). 
 
Beberapa Fungsi yang sering digunakan: 

a.Fungsi Average(…) 

Fungsi ini digunakan untuk mencari nilai rata-rata dari sekumpulan data(range).  Bentuk 
umum penulisannya adalah  =AVERAGE(number1,number2,…), dimana number1, number2, dan 
seterusnya adalah range data yang akan dicari nilai rata-ratanya. 

b.Fungsi Logika IF(…) 

Fungsi ini digunakan jika data yang dimasukkan mempunyai kondisi tertentu. Misalnya, jika 
nilai sel A1=1, maka hasilnya 2, jika tidak, maka akan bernilai 0. Biasanya fungsi ini dibantu oleh 
operator relasi (pembanding) seperti berikut ;  

Lambang  Fungsi  

=  Sama dengan  

<  Lebih kecil dari  

>  Lebih besar dari  

<=  Lebih kecil atau sama dengan  

>=  Lebih besar atau sama dengan  

? 
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<>  Tidak sama dengan  

 

 

c.Fungsi Max(…) 

Fungsi ini digunakan untuk mencari nilai tertinggi dari sekumpulan data (range). Bentuk 
umum penulisannya adalah =MAX(number1,number2,…), dimana number1, number2, dan 
seterusnya adalah range data (numerik) yang akan dicari nilai tertingginya. 

d.Fungsi Min(…) 

Sama halnya dengan fungsi max, bedanya fungsi min digunakan untuk mencari nilai 
terendah dari sekumpulan data numerik. 

e.Fungsi Sum(…) 

Fungsi SUM digunakan untuk menjumlahkan sekumpulan data pada suatu range. Bentuk 
umum penulisan fungsi ini adalah =SUM(number1,number2,…). Dimana number1, number2 dan 
seterusnya adalah range data yang akan dijumlahkan. 

f.Fungsi Left(…) 

Fungsi left digunakan untuk mengambil karakter pada bagian sebelah kiri dari suatu teks. 
Bentuk umum penulisannya adalah =LEFT(text,num_chars). Dimana text adalah data yang akan 
diambil sebagian karakternya dari sebelah kiri, num_chars adalah jumlah karakter yang akan diambil. 

g.Fungsi Mid(…) 

Fungsi ini digunakan untuk mengambil sebagian karakter bagian tengah dari suatu teks. 
Bentuk umum pemakaian fungsi ini adalah =MID(text,start_num,num_chars). Artinya mengambil 
sejumlah karakter mulai dari start_num, sebanyak num_char. 

h.Fungsi Right(…) 

Fungsi ini merupakan kebalikan dari fungsi left, kalau fungsi left mengambil sejumlah 
karakter dari sebelah kiri, maka fungsi mengambil sejumlah karakter dari sebelah kanan teks.. 
Bentuk umum penulisannya adalah =RIGHT(text,num_chars). Dimana text adalah data yang akan 
diambil sebagian karakternya dari sebelah kanan, num_chars adalah jumlah karakter yang akan 
diambil. 

i.Fungsi HLOOKUP dan VLOOKUP 

Fungsi HLOOKUP dan VLOOKUP digunakan untuk membaca suatu tabel secara horizontal 
(VLOOKUP) atau secara vertikal (VLOOKUP). Bentuk umum penulisan fungsi ini adalah :  

=HLOOKUP(Lookup_value, Table_array, Row_index_num,…)  

=VLOOKUP(Lookup_value, Table_array, Col_index_num,…)  

Dari rumus diatas, dapat dilihat bahwa bedanya hanya pada nomor indeksnya saja, kalau 
kita pakai HLOOKUP, maka digunakan nomor indeks baris (Row_index_num), tapi kalu pakai 
VLOOKUP digunakan nomor indeks kolom (Col_index_num). Nomor indeks adalah angka untuk 
menyatakan posisi suatu kolom/baris dalam tabel yang dimulai dengan nomor 1 untuk kolom/baris 
pertama dalam range data tersebut. 

Kegiatan kompetensi 2 : 

Untuk lebih mengerti mengenai rumus dan fungsi-fungsi di atas, perhatikan contoh kasus di 
bawah ini: 

Buatlah tabel seperti di bawah ini pada Microsoft Excel: 

 A B C D E F G H I 

1 DAFTAR NILAI MAHASISWA 

2 SEMESTER GANJIL 2007/2008 

3 UNIVERSITAS KRISTEN DUTA WACANA 
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4          

5  MATA KULIAH : ALJABAR LINIER       

6 GROUP : C        

7          

8 

NIM NAMA 
TGS 

1 
TGS 

2 
TTS TAS 

NILAI KETERANGAN 

9 ANGKA HURUF 

10 22074150 SHANDY GITA 90 90 40 40       

11 22074151 YOHANNES 
PUTRA 

100 90 60 45       

12 22074152 RONI ANGGARA 90 80 75 65       

13 22074153 GO KIEM LIONG 100 100 80 100       

14 22074154 PAULA WINDY 90 80 70 80       

15 22074155 FIONA 
ANDRIANTO 

100 90 70 65       

16 22074156 ROY NALDO 90 100 40 40       

17 22074157 YONGKY 
SETIAWAN 

100 90 50 25       

18 22074158 MATHEUS BIMA 90 80 40 30       

19 22074159 THERESIA 80 80 40 20       

20 NILAI TERTINGGI          - - 

21 NILAI TERENDAH          - - 

22 RATA-RATA          - - 

 

Komponen nilai adalah : 

1. Tugas Sebelum TTS (TGS 1) : 10% 
2. TTS    : 40% 
3. Tugas Setelah TTS (TGS 2) : 10% 
4. TAS    : 40% + 

Nilai   : 100% 

Setelah nilai dalam bentuk angka didapatkan, maka diubah menjadi nilai huruf dengan 
ketentuan sebagai berikut: 

0 E 40 D 55 C 70 B 85 A 100 

Langkah-langkahnya : 

1. Untuk mencari nilai akhir dalam angka, arahkan pointer pada sel G10, kita akan menghitung 
nilai(0-100) dari 4 komponen yang tersedia yaitu TGS 1, TGS 2, TTS, dan TAS. Sesuai dengan 
masing-masing bobot nilai, tuliskan rumus di bawah ini: 
=(C10*0.1)+(D10*0.1)+(E10*0.4)+(F10*0.4) 

2. Selanjutnya untuk G11 sampai G19, tinggal copy-paste dari G10. 
Jika ada yang merasa kesulitan mengcopy-paste, silahkan bertanya pada asisten. 
(Hot key : Copy -> Ctrl+C  & Paste-> Ctrl V) 
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3. Kemudian untuk mengetahui nilai tertinggi dari tugas 1, arahkan pointer ke C20, gunakan fungsi 
yang sudah disediakan di Microsoft Excel yaitu MAX(…). 
=MAX(C10:C19) 

4. Selanjutnya untuk D20 sampai G20, tinggal copy-paste dari C20. 
5. Demikian juga untuk mencari nilai terendah, kita gunakan fungsi Min(…). Arahkan pointer ke 

C21, ketikkan rumus di bawah ini: 
=MIN(C10:C20) 

6. Selanjutnya untuk D21 sampai G21, tinggal copy-paste dari C21. 
7. Untuk rata-rata gunakan fungsi AVERAGE(…), arahkan pointer ke C22. 

=AVERAGE(C10:C19) 
8. Selanjutnya untuk D22 sampai G22, tinggal copy-paste dari C22. 
9. Kemudian untuk mengkonversi dari angka ke huruf, kita menggunakan fungsi logika IF(…), 

arahkan pointer ke H10. 
=IF(G10>=85,"A",IF(G10>=70,"B",IF(G10>=55,"C",IF(G10>=40,"D","E")))) 

10. Selanjutnya untuk H11 sampai H19, tinggal copy-paste dari H10. 
11. Untuk mengisi keterangan, kita aka menggunakan fungsi logika IF(…) lagi, arahkan pointer ke 

I10. Lalu tulis rumus di bawah ini: 
=IF(H10="A","SANGAT BAIK",IF(H10="B","BAIK",IF(H10="C","CUKUP",IF(H10="D"," 
KURANG","TIDAK  LULUS")))) 

12. Selanjutnya untuk I11 sampai I19, tinggal copy-paste dari I10. 

Setelah selesai silakan simpan hasil kerja anda dengan nama file baru : latihan2.xls. 
Ingat!! Jawaban untuk kolom NILAI harus dengan rumus fungsi diatas tidak boleh manual!! 

 
Jika benar, maka hasilnya akan seperti ini: 

 A B C D E F G H I 

1 DAFTAR NILAI MAHASISWA 

2 SEMESTER GANJIL 2007/2008 

3 UNIVERSITAS KRISTEN DUTA WACANA 

4          

5 MATA KULIAH : ALJABAR 
LINIER 

       

6 GROUP : C        

7          

8 NIM NAMA TGS 
1 

TGS 2 TTS TAS NILAI KETERANGAN 

9 ANGKA HURUF 

10 22074150 SHANDY GITA 90 90 40 40 50 D KURANG 

11 22074151 YOHANNES 
PUTRA 

100 90 60 45 61 C CUKUP 

12 22074152 RONI ANGGARA 90 80 75 65 73 B BAIK 

13 22074153 GO KIEM LIONG 100 100 80 100 92 A SANGAT BAIK 

14 22074154 PAULA WINDY 90 80 70 80 77 B BAIK 

15 22074155 FIONA 
ANDRIANTO 

100 90 70 65 73 B BAIK 

16 22074156 ROY NALDO 90 100 40 40 51 D KURANG 

17 22074157 YONGKY 
SETIAWAN 

100 90 50 25 49 D KURANG 

18 22074158 MATHEUS BIMA 90 80 40 30 45 D KURANG 

19 22074159 THERESIA 80 80 40 20 40 D KURANG 

20 NILAI TERTINGGI 100 100 80 100 92 - - 

21 NILAI TERENDAH 80 80 40 20 40 - - 

22 RATA-RATA 93 88 56.5 51 61.1 - - 
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Kegiatan kompetensi 3 : 

Buka workbook baru dan ganti nama Sheet1 menjadi Laporan. Ketik laporan berikut pada 
sheet laporan. 

 

 

 A B C D E F G 

1 DAFTAR PESERTA UJIAN PELATIHAN KOMPUTER 

2 DUTA TRAINING CENTER 

3 UNIVERSITAS KRISTEN DUTA WACANA 

4        

5 NO KODE NAMA MATERI BIAYA WAKTU KELAS 

6 1 A-P-050 ARDI         

7 2 B-S-041 BOBBY         

8 3 C-P-042 JONI         

9 4 D-S-170 SETIAWAN         

10 5 A-M-010 AGUS         

11 6 B-M-151 RUDY         

 
 
Ganti Sheet2 menjadi Tabel Anak, dan ketik data berikut: 

 

 

 

 

 

Ketentuan proses : 

 Materi 

Didapat dengan membaca table anak yang terdapat pada Tabel Anak dengan kunci pembacaan, 

dengan melihat karakter pertamanya. 

 Biaya 

Didapat dengan membaca table anak yang terdapat pada Tabel Anak dengan kunci pembacaan 
Kode. 

 Waktu 

Didapat dengan ketentuan, jika karakter  ke-3 dari Kode = “P” maka “Pagi”, jika “S” maka “Siang”, 
sedangkan jika “M” maka “Malam”. 

 A B C 

1 KODE MATERI BIAYA 

2 A Microsoft Word 25000 

3 B Microsoft Excel 35000 

4 C Java 45000 

5 D Visual Basic 50000 

Klik kanan pada Sheet1, 

kemudian pilih  Rename & 

ganti nama Sheet1 menjadi 

Laporan. 
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 Kelas 

Didapat dengan ketentuan, jika karakter ke-5 Kode=0 maka “Regular”, sedangkan jika 1 maka 
“Diploma”. 

Penyelesaian: 

 Materi 

Pada sel D6 =VLOOKUP((LEFT(B6,1)),'Tabel Anak'!$A$2:$C$5,2) 

Tanda ‘$’ digunakan sebagai fungsi absolute/mutlak. 

 Biaya 

Pada sel  E6 =VLOOKUP(LEFT(B6,1),'Tabel Anak'!$A$2:$C$5,3) 

 Waktu 

Pada Sel F6 =IF(MID(B6,3,1)="P","Pagi",IF(MID(B6,3,1)="S","Siang","Malam")) 

 Kelas 

Pada Sel G6 =IF(MID(B6,5,1)="0","Regular","Diploma") 

 

Kegiatan kompetensi 4 : 
1. Buka workbook baru, dan buat tabel seperti dibawah ini: 

Kode Barang Merk Jumlah Harga Total Keterangan 

N-12C      

S-10K      

S-05K      

N-23C      

M-90K      

 
Ketentuan Proses: 

 Merk 

Jika karakter pertama dari Kode Barang=”N”, maka “NOKIA”, jika “S” maka “SAMSUNG”, dan “M” 
adalah “MOTOROLA. 

 Jumlah 

Mengambil karakter ke-3 dan ke-4 Field Kode Barang 

 Harga 

Jika Merk NOKIA 799.000 

Jika Merk SAMSUNG 599.000 

Jika Merk Motorola 499.000 

 Total 

Merupakan perkalian antara Jumlah dengan Harga 

 Keterangan 

Jika karakter terakhir Kode Barang=”C” maka “Cash” 

Jika karakter terakhir Kode Barang=”K” maka “Kredit” 

(Simpan dengan nama file latihan4.xls) 
 
Uji kompetensi 3 
A.Pilihlah Salah Satu Jawaban Yang Tepat 

1. Setiap perhitungan rumus/ formula harus didahului dengan lambang yaitu ........... 
a. + 
b. = 
c. @ 
d. # 

2. Fungsi untuk perhitungan rata-rata menggunakan perintah .......... 
a. Sum 
b. Average 
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c. Count 
d. Max 

3. Perintah untuk perhitungan banyaknya jumlah data adalah ........ 
a. Sum 
b. Average 
c. Count 
d. Max 

4. Untuk penulisan rumus jumlah di sel B2 dengan sel C2 yang benar di bawah ini adalah 
a. +Sum(B2...C2) 
b. =Sum(B2:C2) 
c. =Sum(B2;C2) 
d. =Sum(B2...C2) 

5. Perintah untuk menghitung jumlah cell yang berisi data numeric atau string adalah ... 
a. Sum 
b. Counta 
c. Count 
d. Countif 

6. Untuk mencari nilai tengah dari jumlah angka adalah ........ 
a. Median 
b. Average 
c. Count 
d. Choose 

7. Perintah untuk membandingkan 2 buah keadaan atau lebih adalah .... 
a. OR 
b. AND 
c. IF 
d. TRUE 

8.  Yang termasuk rumus untuk IF yang benar penulisannya adalah ...... 
a. if(Perbandingan;Nilai jika benar,Nilai jika salah) 
b. =if(Perbandingan:Nilai jika benar:Nilai jika salah) 
c. =if(Perbandingan,Nilai jika benar:Nilai jika salah) 
d. = if(Perbandingan;Nilai jika benar;Nilai jika salah) 

9. Untuk pengisian keterangan di sel E5, jika nilai pembelian lebih besar sama dengan 15000 
maka bonus jika kurang dari 15000 maka tidak ada Bonus adalah ........ 
a. =if(E5>=15000.’Bonus’,’Tidak ada Bonus’) 
b. =if(E5>=15000,”Bonus”,”Tidak ada Bonus”) 
c. =if(E5>=15000.’Bonus’:’Tidak ada Bonus’) 
d. =if(E5>=15000.’Bonus’;’Tidak ada Bonus’) 

10. Simbol operator operasi eksponensial / pemangkatan dari operator aritmatika adalah … 
     a. +  b. / c. *         d. ^ 

11. Dalam perhitungan Excel Hasil dari 2^4 adalah …. 

a. 8   c. 0,5 

b. 4   d. 16 
12. Dalam perhitungan Excel Hasil dari =(2+4)*(2^2) adalah …. 

a. 14 b.24 c. 28    d. 32 
13. Pada rumus =AVERAGE (B5:B12) , jumlah sel yang terlibat adalah … 

a. 14   c. 10 

b. 12   d. 8 
14. Perhatikan tampilan di bawah ini : 

  A B C 

1 NILAI ULANGAN TIK 

2       

3 No Nama Nilai TIK 

4 1 Andi 74 

5 2 Mila 72 

6 3 Nina 70 

9 Jumlah …………….. 

10 Rata-rata …………….. 
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Rumus fungsi yang tepat diisikan pada  sel  C9  adalah………. 
a. =average(C4:C6) 
b. =sum(C4:C6)  
c. =average(C3:C6) 
d. =sum(C3:C6) 

15. Jumlah kotak/sel yang terlibat dalam rumus   =average(C4:C6) sebanyak……… 
a.  3 
b.  6 
c.  72 
d.  9 

16. Fungsi dibawah ini yang bekerja sebagai fungsi logika  adalah …. 
a. Count  
b. Average 
c. IF  
d. Sum 

17. Penulisan rumus =C1+C2+C3.....+C6   identik dengan fungsi ..... 
a. =MAX(C1:C6) 
b. =SUM(C1:C6) 
c. =MIN(C1:C6) 
d. =COUNT(C1:C6) 

18. Siswa dikatakan lulus jika nilai minimal 6, maka rumus yang benar adalah …. 
a. =if(nilai>6;”Lulus”) 
b. =if(nilai<6;”Lulus”)  
c. =if(nilai>=6;”Lulus”) 
d. =if(nilai<=6;”Lulus”)  

19. Untuk penulisan rumus yang benar Vlookup adalah ........ 
a. Vlookup(NilaiKunci:Range table:Nomor Indek Kolom) 
b. Vlookup(NilaiKunci;Range table;Nomor Indek Kolom) 
c. Vlookup(NilaiKunci,Range table;Nomor Indek Kolom) 
d. Vlookup[NilaiKunci,Range table,Nomor Indek Kolom] 

20. Untuk mencari suatu nilai, dari suatu tabel pencarian pada baris yang telah ditentukan 
dengan metode pencarian menurun (vertical) mengunakan………… 
a.  IF                       c.  ANG 
b.  VLOOKUP        d.  HLOOKUP 

21. Hasil dari  = 33<=23  adalah …. 
a. TRUE c. #name?# 
b. FALSE d. #N/A# 

22. Fungsi text berikut yang digunakan untuk mengambil 5 karakter dari cell H2 mulai hitungan  
ke 4 adalah …. 
a. =MID(H2;4;5) c. =MID(4;H2;5) 
b. =MID(5;H2;4) d. =MID(4;5;H2) 

      Untuk soal 23,24,25,dan 26 perhatikan 
      Diketahui : A 
 
                     1 B081219273HU 

Gunakan data diatas untuk menjawab soal (no 23 s/d 26) sebagai berikut : 
23. =Left(A1;3) hasilnya adalah … 

a. B08                   c.  81 
b.  3HU                  d.  12 

24. =Right(A1;3) hasilnya adalah … 
a.B0                        c.  81 
b.3HU                     d.  12 

25. =Mid(A1;3;2) hasilnya adalah … 
 a. B0                      c.  81 

b.3HU                 d.  12 
26. =Len(A1) hasilnya adalah … 

a. B08            c.  81 
b.  3HU                 d.  12 
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27. = ( A6+B6+C6+D6+E6)  apabila ditulis dengan perintah SUM adalah… 
a. = SUM ( A6..B6)  c.  = SUM (A6,B6,C6,D6,E6) 
b. = SUM (A6:B6)  d.  = SUM (6(A,B,C,D,E)) 

28. Range A1..C4 beranggotakan .... 
a. empat buah alamat pengetikan c. empat lembar kerja Excel 
b. duabelas buah cell   d. tiga buah buku kerja Excel 

29. Kelompok operator aritmatika yang benar adalah .... 
a. kali, bagi, kurang , tambah, pangkat c. lebih kecil, lebih besar, sama dengan 
b. kurung, and, or, not   d. and, or, not  

30. Data yang dihasilkan dari fungsi LEFT bertipe .... 
 a. numerik atau karakter  c. numerik atau string 
b. numerik atau string atau karakter d. pasti bukan numerik 

B. lengkapilah soal berikut dengan jawaban yang tepat 
1. Untuk membentuk operasi-operasi matematika dasar seperti penjumlahan, pengurangan dan 

pembagian mengunakan operator… 
2. Untuk perpangkatan dalam excel mengunakan symbol 
3. Tanda <= merupakan operator perbandingan yang artinya.. 
4. Apa yang dimksud dengan alamat relative 
5. Agar rumus tidak berubah setiap ada perubahan sel, maka harus diberi tanda.. 
6. Pernyataan benar dalam excel akan dituliskan dengan 
7. Untuk mencari nilai terendah digunakan rumus.. 
8. Untuk mencari nilai rata-rata digunakan rumus.. 
9. Apabila dalam cel A1 dituliskan “ SMPIT NH” kemudian di cel A2 dituliskan rumus =right(A1;5), 

maka akan muncuk tulisan.. 
10. Apabila dalam cel A1 dituliskan “ SMPIT NH” kemudian di cel A2 dituliskan rumus =lower(A1), 

maka akan muncuk tulisan.. 
11. Perkalian dalam excel mengunkaan operator…. 
12. Apabila kita mengunakan rumus =100% hasilnya.. 
13. Apabila kita mengunakan rumus =10^2 hasilnya.. 
14. Dalam excel untuk menentukan persamaan mana yang harus dihitung dulu digunakan tanda … 
15. Apa bila kita memasukkan data =4>3 hasilnya…FALSE 
16. Jika di sel B5 kita isi =sum(A1:B4) berapa sel yang dihitung…  
17. Apa bila kita mengetik =count(G4:J4) maka kita akan memperoleh hasil… 
18. Vlookup adalah rumus yang digunakan untuk kolom dengan arah.. 
19. Untuk mencari nilai tertinggi dalam suatu data kita mengunakan rumus.. 
20. Agar kata “sekolah” dalam sel A1 agar menjadi “SEKOLAH” maka rumusnya adalah.. 

C.Jawablah Soal-Soal Berikut Dengan Singkat Dan Tepat 

1. Apa saja yang termasuk opetaror perbandingan? 
2. Apa yang kalian kethui tentang operator aritmatika? 

3. Bagimana langkah-langkah untuk mengkopikan rumus.. 

4. Jelaskn bagaimana cara menuliskan alamat mutlak pada sebuah rumus.. 

5. Apa yang kalian ketahui tentang fungsi dalam excel 

6. Apa fungsi rumus statistic average.. 

7. Jelaskan fungsi logika if.. 

8. Jelaskan fungsi Vlookup.. 

Untuk soal no 9 dan 10 perhatikan data berikut  
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9. Apa rumus jumlah Total pada sel D6 dan E6 

10. Apa rumus nilai rata-rata pada sel D7dan E7 

 
 
SOAL Remidi 
1. Apa saja yang termasuk operator perbandingan? 
2. Jelaskan tentang alamat relative…. 

3. Jelaskan tentang alamat mutlak… 

4. Jelaskan fungsi Hlookup… 

5. Jelaskan fungsi average… 

6. Jelankan fungsi Mid… 

7. Jelalaskan fungsi dati SUM… 

8. Jelaskan fungsi COUNT… 

9. Jelaskan fungsi right.. 

10. Jelaskan Proses perhitungan dalam perhitunga dasar dengan mengunakan operator ^,*,/,+ … 

 
Portofolio 
Lengkapilah tabel di bawah ini dengan menggunakan table di sebelahnya sebagai patokan! Simpan 
dengan nama file latihan5.xls. 

 

 

 
 
 

BAB 4 
MENGELOLA DATA DAN GRAFIK 

 
Standar Kompetensi: 
Menggunakan perangkat lunak pengolah angka untuk menyajikan informasi 
 
Kompetensi Dasar: 
Membuat dokumen pengolah angka sederhana 
 
Kelas/semester: 
VIII/Genap 
 
Karakter Siswa yang Diharapkan 
Jujur, Disiplin,  Kerja Keras, Kreatif, Mandiri, Rasa Ingin Tahu 
 
Ringkasan Materi 
 
A. MENGURUTKAN DATA DENGAN SORT 

Sort  adalah perintah untuk mengurutkan data berdasarkan kondisi tertentu. Cara 
menggunakan perintah ini adalah sebagai berikut : 
Tempatkan kursor di dalam tabel data. 
1. Klik menu Data. 
2. Pada ribbon-bar klik Sort. 

Nama Kode Jenis Buku Harga 

Hani DR     

Jerry HR     

Wawan HR     

Marina KM     

Novi DR     

Ratih LG     

Kode 
Film 

LG DR HR KM 

Jenis Laga Drama Horor Komedi 

Harga 2500 2000 3000 2700 
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Kotak dialog Sort akan tampil seperti berikut ini. 

 
Keterangan: 
 Bagian Sort by berisikan nama field atau nama kolom yang digunakan sebagai acuan 

pengurutan data. 
 Bagian Sort On digunakan untuk menentukan tipe data yang ingin diurutkan. 
 Bagian Order digunakan untuk menentukan kondisi pengurutan data, yaitu secara Ascending 

(menaik) atau Descending (menurun). 
 Tombol Add Level digunakan jika kita ingin mengurutkan data pada beberapa kolom atau 

beberapa baris sekaligus. 
 Tombol Options digunakan untuk menentukan arah pengurutan data, apakah berdasarkan 

kolom (dari atas ke bawah) atau berdasarkan baris (dari kiri ke kanan). 
 Pilihan My data has headers sebaiknya diaktifkan agar pada bagian Sort by dapat terlihat judul 

kolom atau judul baris yang terdapat pada tabel. 
Sebagai contoh, pada tabel penjualan berikut ini: 

 
Untuk mengurutkan nilai penjualan dari nilai terkecil sampai ke nilai terbesar, pilih field PENJUALAN 
1 pada bagian Sort by lalu tekan tombol Ok. 
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Perhatikan tampilan data yang telah mengalami perubahan seperti berikut ini. Kolom PRODUK tidak 
berurutan namun kolom PENJUALAN 1 telah diurutkan. 

 
 
B. MENYARING DATA DENGAN FILTER 
Untuk melakukan pencarian informasi suatu data pada excel 2007, diantaranya dapat dilakukan 
dengan cara menyaring data menggunakan fasilitas Data Filter. 
 
1.Menyiapkan Penyaringan Data  
Untuk menyiapkan penyaringan data dengan fasiitas Data Filter, langkahnya adalah: 
a. Sorotlah range yang mencakup seluruh judul kolom yang ada pada baris judul data. Sebagai 

contoh gunakan Daftar Sewa Merk seperti pada Gambar 11.1, kemudian sorot range seluas 
B7:G17.  

 
b. Pada Tab Data,dalam Grup Sort & Filter, klik dengan langkah ini fasilitas Data Filter 

akan otomatis diaktifkan dan tombol daftar pilihan (drop-down) akan ditampilkan pada setiap 
judul kolom yang ada dibaris judul.  
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Gambar Tampilan Setelah Memberikan Perintah Filter 
 

2. Menyaring Data 
Untuk menyaring database cukup dilakukan dengan cara mengklik tombol daftar pilihan (tombol 
drop-down) pada nama field (judul kolom) yang diinginkan, kemudian pilih dan klik criteria 
penyaringannya. Berikut ini akan diberikan beberapa contoh penyaringan database. 
 Jika yang ingin ditampilkan hanya data Sewa Mobil untuk merk TOYOTA AVANZA, pilih dan klik 

tombol drop-down MERK. 
 Pada kotak daftar pilihan dibawah Text Filters, pilih dan klik criteria penyaringan yang ingin 

digunakan. Karena ingin menampilkan data untuk merk TOYOTA AVANZA, maka klik “TOYOTA 
AVANZA”. Lihat gambar dibawah 

 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar Kotak Pemilihan Kriteria Penyaringan 
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Gambar Tampilan Hasil Filter dengan Kriteria Merk 
 
3. Menyaring Data dengan Custom Filter 
Anda dapat juga menyaring database dengan kriteria khusus yang ditentukan sendiri menggunakan 
pilihan Custom Filter. Untuk menyaring database dengan menggunakan Custom Filter, langkahnya 
adalah: 
a. Jika yang ingin ditampillkan adalah seluruh Data Sewa Mobil yang Lama Sewanya di atas 10 hari. 

Untuk itu pilih dan klik tombol daftar pilihan (tombol drop-down) LAMA. 
b. Pada menu yang ditampilkan, pilih dan klik Number Filters > Greater Than. Kotak dialog Custom 

Filter akan ditampilkan. Lihat Gambar 
 
 
 
 
 
 
 
 
 
 
 
 
Gambar Pemilihan Text Filters 

 
c. Pada baris pertama kotak Show rows where LAMA, pilih dan klik “is greater than”, kemudian 

ketikkan angka 10 atau lakukan pemilihan angka unit penjualan melalui tombol drop-down yang 
ada. Lihat Gambar Kotak Dialog Custom Autofilter Klik OK. Maka Data Sewa Mobil hanya akan 
menampilkan record data yang Lamanya lebih besar dari 10 hari. Lihat Gambar dibawah 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
C. CARA MENYISIPKAN DIAGRAM  

Untuk lebih meningkatkan pemahaman pada pembaca, data-data yang terdapat di dalam 
tabel dapat diubah bentuknya menjadi diagram. Ada beberapa jenis diagram, di antaranya diagram 
batang, diagram garis, dan diagram lingkaran. Setiap diagram memiliki fungsi yang berbeda-beda. 
Ada dapat mengingat kembali macam-macam diagram dan kegunaannya pada mata pelajaran 
matematika. Sebelum membuat diagram, Anda harus membuat terlebih dahulu koleksi data yang 
diperlukan. Sebagai contoh koleksi data, dapat Anda lihat pada gambar berikut ini. 
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Gambar Data awal 
 
Blok sel B1 sampai ke sel E8. Klik tab Insert, periksa grup Chart. Klik pada tombol jenis Chart yang 
diinginkan, contohnya klik tombol Column, kemudian klik tombol pertama dari grup 3-D column. 

 
  

Gambar  Kumpulan 3-D column 
Akhirnya, Anda akan mendapatkan bentuk chart seperti ilustrasi berikut ini. 

 
Gambar  Hasil Chart 
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Anda akan menemukan tab ribbon baru, Chart Tools – Design, klik tombol Select Data. 

  
Pada grup Data. Klik tombol Edit, Pada kotak Horizontal (Category) Axis Labels. 

  
Gambar Kotak dialog Select Data Source 
 
Blok sel A2 sampai A8. Klik tombol OK pada dialog Axis Labels. Klik tombol OK pada dialog Select 
Data Source, perhatikan tampilan grafik sekarang. Pilihlah salah satu tampilan pada grup Chart 
Layout. 

 
Tampilan akhir grafik dapat tampak seperti ilustrasi berikut ini. 

 
Gambar Contoh grafik 

 
 
Kegiatan kompetensi 1 
Cobalah untuk mengekplorasi fitur-fitur lain yang disediakan pada ribbon Chart Tool – Design. 
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Gambar Pengaturan grafik dapat dilakukan melalui tab Format 

 
Keterangan: 

No Nama Sub Tab Kegunaan 

1 Current 
Selection 

 

A Chart Area Digunakan untuk menyeleksi area grafik yangakan dimodifikasi 

B Format 
Selection 

Untuk mengatur format pada area grafik(khususnya bingkai grafik) yang dipilih 

C Reset to 
match style 

Mengembalikan/menghilangkan format kesemula 

2 Shape Style Untuk membuat/memodifikasi bingkai grafik 

3 WordArt Style Untuk membuat dan memodifikasi teks padagrafik dengan format huruf indah 
(WordArt), sekaligus dengan pewarnaannya 

4 Arrange Untuk mengatur tata letak grafik 

5 Size Untuk mengatur ukuran grafik dalam dokumen 

 
Dari masing-masing subtab tersebut Anda dapat memodifikasi grafik sesuai selera Anda dengan data 
grafik sebagai sama dengan data awal berikut ini: 
 

 
 
 
Kegiatan kompetensi 2 
Buatlah grafik dari data seperti berikut ini 

merk bulan 

jan feb mar apr mei  jun 

toshiba 25 30 35 40 45 50 

acer 60 55 50 45 40 35 

ibm 95 95 95 50 35 20 

zirex 130 135 140 55 30 5 

dell 165 175 185 60 25 10 
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Uji kompetensi 4 
A. pilihlah salah satu sola berikut dengan tepat 
1. Fasilitas yang digunakan untuk mencari kumpulan data yang memenuhi criteria tertentu   

adalah…. 
a. Filter          c. Autofilter 

 b. Sorting      d. Custom 

2. Untuk menurutkan data diawali dengan meyorot data kemudian memilih tab… 
a.Insert   c.Edit 

b.Format   d.Data 

3. Sort ascending digunakan untuk … 
a. mengurut data dari kecil ke besar  

b. mengurut data dari besar ke kecil 

c. menyaring data dari kecil ke besar  

d. menyaring data dari besar ke kecil 

4. Untuk membuat data secara berurut secara alphabet dari kecil kebesar adalah memilih icon …. 

 a.    c.  

 b.    d.  
5. Untuk pembuatan grafik maka kita dapat mengklik icon .... 
 a. Sort Ascending  c. autosum 
 b. Sort Descending  d. Chart Wizard 
6. Untuk menampilkan seluruh data pada Autofilter digunakan pilihan…. 
       a. Show All                              c. All Filter 
       b. General                              d. Automatic 
7. group yang digunakan untuk membuat insert grafik adalah…. 

  a. Open                                 c. insert 
  b. Chart Wizar                    d. Charts       

8. Perintah untuk mengurutkan data dari nilai terbesar ke nilai terkecil (A ke Z) pada pengurutan 
data (Data Sort), adalah …. 

a. Cresending  
b. Ascending  
c. SortSending  
d. Descending  

untuk no 9  perhatikan gambar grafik berikut ini : 
 
 
 
 
 
 
 

 
9. Tipe grafik di atas disebut...... 

a.  Column 
b.  Bar 
c.  Line 

         d.  Pie 
10. Untuk Aktifkan graph- klik chart- pilih option- klik titles – klik OK – klik diluar kotak graph 

adalah… 
a. Mengubah jenis grafik  c. membuat grafik 
b. Membuat judul grafik  d. memindahkan grafik 

11. Untuk membuat grafik, bagian table yang perlu untuk diblok adalah… 
a. Seluruh data   c. Seluruh tabel 
b. Judul tabel    d. Semua benar 

12. Untuk autosum maka kita dapat mengklik icon .... 
a. Sort Ascending  c. autosum 
b. Sort Descending  d. Chart Wizard 
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13. Dibawah ini yang bukan merupakan jenis-jenis bentuk grafik adalah .... 
 a. column   c. elips 
 b. XY   d. cylinder 
14. Sort & filter merupakan group yang terdapat pada tab  
       a. home                                c. data 
       b. insert                                d. view 
15. perhatikan data berikut 

NO NAMA NIM FAKULTAS IPK 

1 WIRATNO C0205052 FSSR 3,2 

2 Herwening Rara Kusumaningsih C0107007 FSSR 3,3 

3 Eko Haryanto C0205025 FSSR 3,4 

4 IKA KURNIAWATI C0206025 FSSR 3,5 

5 Anggoro Dwi Jayanto C0207012 FSSR 3,6 

6 Hary Sulistyo C0207028 FSSR 3,7 

7 Lina Tri Permana Sari C0208030 FSSR 3,8 

8 Ulwa Humairok Gandes L C0506053 FSSR 3,9 

Kolom yang diurutkan sesuai dengan ascending adalah… 
a. No dan nama 
b. Nomor dan nim 
c. Nama dan IPK 
d. No dan IPK 

16. Perhatikan gambar berikut 

 
Untuk nambah level sorting kita klik pada 

a. Add level 
b. Delete level  
c. copy level 
d. options 

17. Perhatikan gambar berikut 
 

 
Pilihan sort options tersebut berarti mengurutkan dari… 

a. Atas ke bawah 
b. Bawah ke atas  
c. Kanan ke kiri 
d. Kiri ke kanan 

Perhatikan gambar berikut untuk nomer 18 dan 19 

 
 
 
           1         2         3        4                    5 
18. Yang merupakan tampilan pilihan coloumn adalah 

a.1  b.2 c.3 d.5 
19. Yang merupakan tampilan pilihan scater adalah 
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a.1  b.2 c.3 d.5 
20. untuk memasukkan grafik kedalam lembar kerja melui menu insert pada tab.. 

a. home 
b. insert 
c. data 
d. view 

B.lengkapilah soal berikut dengan jawaban yang tepat! 
1. Untuk mengurutkan data mengunakan perintah.. 
2. Melakukan editing grafik dilakukan di tab.. 
3. Mengurutkan data dari besar ke kecil mengunakan perintah.. 
4. Then by kita isi apabila… 
5. Tombol  yang digunakan jika kita ingin mengurutkan data pada beberapa kolom atau beberapa 

baris sekaligus adalah….  
6. fasilitas yang digunakan untuk menyeleksi area grafik yang akan dimodifikasi adalah…  
7. Dalam menyaring data dengan pilihan menampilkan data terkecil dengan memilih.. 
8. Dalam menyaring data text untuk menampilkan data yang mempunyai karakter yang sama 

dengan karakter yang ditentukan mengunakan pilihan… 
9. Tab chart tools terdiri dari … 
10. Untuk mengatur tampilan legenda pada grafik memilih tab… 

 
C.Jawablah pertanyaan-pertanyaan di bawah ini dengan benar ! 
1. Bagaimana langkah-langkah menyortir daftar berdasarkan 2 kolom/level? 
2. Bagaimana langkah-langkah untuk menyaring data dengan fasilitas filter? 
3. Bagaimana langkah-langkah membuat grafik? 
4. Jelaskan fungsi then by dalam kotak dialog short! 
5. Jelaskan langkah-langkah meyaring data dari yang terbersar ke yang terkecil! 
 
Soal remidi 
1. Jelaskan yang dimaksud dengan short 
2. Jelaskan yang dimaksud dengan filter 
3. Sebutkan jenis-jenis grafik  
4. Jelaskan bagaimana cara memodifikasi grafik 
5. Bagaimana cara merubah skala grafik pada sumbu x dan y 
 
Portofolio 
Tuliskan tinggi badan teman sekelasmu kemudian masukkan dalam tabel dan buatlah grafik 
 
 
 
ULANGAN BLOK AKHIR SEMESTER 
A. Pilihlah salah satu jawaban yang paling tepat ! 
 

1. Lembar kerja Excel berbentuk tabel yang terdiri dari baris dan kolom, setiap kotak yang 
merupakan pertemuan/perpotongan baris dan kolom disebut…. 

a. Cells    b. Row    c. Colum d.  Sheet 

2. Sebuah sel mempunyai alamat M16 maka sel tersebut berada pada …. 

a. kolom 16 baris 6 

b. kolom 16 baris M 

c. kolom M baris 16 

d. kolom M baris 6 

3. Bagian Excel yang digunakan untuk menggerakkan lembaran kerja dalam arah mendatar adalah 
…. 

a. align vertikal 

b. align horizontal 

c. scroll bar vertikal 

d. scroll bar horizontal 

4. Untuk menyimpan sebuah dokumen kita menggunakan perintah Save, atau dengan ikon …. 
 a.      b.           c.  d.           
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5. Untuk membuat lembar kerja baru kita bisa menggunakan perintah dari keyboard yaitu …. 
a. Ctrl+A  c. Ctrl+O 
b. Ctrl+N  d. Ctrl+V 

 

6. Perhatikan gambar di bawah!(No 8, 9 dan 10) 

 
 
Untuk mengganti jenis huruf / Font kita bisa menggunakan bagian nomor …. 
a. 1 b. 2 c. 3      d. 4 

7. Bagian yang berfungsi memberi Border pada tabel yang dibuat ditunjukkan dengan nomor …. 
a. 1  b. 2 c. 3 d. 4 

8. Bagian no. 4 berfungsi …. 

a. menggabungkan sel 

b. mengganti jenis huruf 

c. memberikan border pada tabel 

d. mengubah ukuran huruf 

9. Tanda pemisah antara hari, bulan dan tahun pada penulisan data berupa tanggal adalah  

a. spasi 

b. spasi dan (/) 

c. (-) dan (/) 

d. spasi dan (-) 

10. Pada lembar kerja Excel penulisan yang benar dari tanggal “20 Maret 2010” adalah  

a. 20/Maret/2010 

b. 2010/Maret/20 

c. 20/03/2010 

d. 03/20/2010 

11. Kita sering menjumpai tanda ########### pada sel, maksudnya adalah.... 

a. data yang dimasukan tidak bisa dihitung 

b. format data yang dimasukan salah 

c. lebar kolom terlalu kecil untuk menampilkan data angka yang dimasukan 

d. rumus yang dimasukan salah 

12. Untuk menambahkan kolom, kita menggunakan perintah …. 

a. Insert Cells 

b. Insert Sheet 

c. Insert Row 

d. Insert Column 

13. Untuk menghapus baris dapat dilakukan dengan menggunakan perintah .... 
a. Klik kanan,  Delete, pilih Entire Column 
b. Klik kanan, Delete, pilih Shift cells left 
c. Klik kanan, Delete, pilih Entire Rows 
d. Klik kanan, Delete, pilih Shift cells up 

14. Simbol operator operasi pembagian dari operator aritmatika adalah … 
a. +  b. / c. *         d. ^ 

15. Dalam perhitungan Excel Hasil dari 2*4 adalah …. 

a. 8   c. 0,5 

b. 4   d. 16 

16. Dalam perhitungan Excel Hasil dari =4-(2^2) adalah …. 

b. 0 b.4 c. 8    d. -4 

17. Fungsi yang digunakan dalam mendapatkan jumlah dalam range data nilai tertentu adalah … 
a. SUM    c. AVERAGE 
b. MAX    d. MIN 

18. Pada rumus =AVERAGE (B5:B12) , jumlah sel yang terlibat adalah … 

1 2 3 4 
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a. 14   c. 10 

b. 12   d. 8 
Untuk no 19 dan 20  Perhatikan gambar berikut……….. 

  A B C D 

1 DATA SISWA MTs  MANDIRI   

2         

3 
No Kelas 

Jumlah 
Siswa   

4 1 7 121   

7 Jumlah     

19. Kata  “JUMLAH”   merupakan merge sel dari  … 
a. A7 dan B7 
b. A4 dan B4 
c. A3 dan C3 
d. A4 dan C4 

20. Daerah yang diblok atau disorot pada tabel di atas adalah sel .... 
a.  A1 : C1   
b.  B4 : B6  
c.  A3 : C4 
d.  C4 : C6 

21. Short cut untuk membatalkan perintah adalah....... 
a. Crtl+Z 
b. Crtl+Y 
c. Crtl+X 
d. Crtl+R 
e.      

22. Tombol untuk menghapus isi sebuah cell: 
a. backspace  
b. Delete 
c. esc  
d. Break     

23. Langkah-langkah menyalin sebuah sel yang benar ialah : 
a. Kilk sel sumber  Ctr+C  Klik sel tujuan  Ctr+V 
b. Kilk sel sumber  Ctr+A  Klik sel tujuan  Ctr+P 
c. Kilk sel sumber  Ctr+V  Klik sel tujuan  Ctr+C 
d. Kilk sel sumber  Ctr+D  Klik sel tujuan  Ctr+V 

24. Fungsi dibawah ini yang bekerja untuk menhitung jumlah data numerik  adalah …. 
a. Sum  
b. Average 
c. Min 
d. Count 

25. Fungsi dibawah ini yang bekerja sebagai fungsi text adalah …. 
a. Count  
b. Average 
c. right  
d. Sum 

26. Mahaiswa dikatakan baik jika ipk lebih besar atau sama dengan 3, maka rumus yang benar adalah 
…. 

a. =if(nilai>3;”baik”) 
b. =if(nilai<3;” baik”)  
c. =if(nilai>=3;” baik”) 
d. =if(nilai<=3;” baik”)  

27. Untuk penulisan rumus yang benar Vlookup adalah ........ 

a. Vlookup(NilaiKunci:Tange table:Nomor Indek Kolom) 

b. Vlookup(NilaiKunci;Tange table,Nomor Indek Kolom) 

c. Vlookup(NilaiKunci,Tange table,Nomor Indek Kolom) 

d. Vlookup[NilaiKunci,Tange table,Nomor Indek Kolom] 
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28. Untuk mencari suatu nilai, dari suatu tabel pencarian pada baris yang telah ditentukan dengan 
metode pencarian mendatar mengunakan………… 
a.  IF                  c.  ANG 
b.  VLOOKUP      d.  HLOOKUP 

29. Fasilitas yang digunakan untuk menurutkan data   adalah…. 
a. Filter       c. Autofilter 
b. Sorting    d. Custom 

30. Hasil dari  = 33=23  adalah …. 
a.TRUE c. #name?# 
b.FALSE d. #N/A# 

 
B.Jawablah pertanyaan-pertanyaan di bawah ini dengan benar ! 
1. Jelaskan bagaimana membuka file excel ? 
2. Apa yang kalian ketahui tentang tab dan tombol office ? 
3. Bagaimana cara menambah lembar kerja baru ? 
4. Apa yang dimasuk dengan range? 
5. Jelaskan bagaimana mengkopi data? 
6. Jelaskan bagaimana mengatur lebar kolom! 
7. Jelaskan bagaimana membuat rumus dalam excel 
8. Jelaskan baimana cara mengurutkan data dari data terkecil hingga terbesar 
Soal Nomor 9 dan 10 lihat gambar berikut! 

 

9. Tuliskan rumus Sewa/hari pada sel D7! 
10. Tuliskan Rumuas Diskon pada sel I7!  
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PENGAYAAN 
 
A.Menggunakan Hitungan Matematika Excel 2007 
Pada pelajaran matematika, kita mengenal berbagai macam operator yang digunakan untuk 
menghitung. Dalam berbagai fungsi dan rumus, Microsoft Excel menggunakan operator matematika. 
Tabel berikut memperlihatkan contoh pemakaian operator matematika pada perangkat lunak 
pengolah angka tersebut. 
 

Keterangan Matematika Microsoft Excel 

Tambah 5 + 5 5 + 5 

Kurang 5 – 5 5 – 5 

Kali 5 x 5 5 * 5 

Bagi 10/2 10/2 

Pangkat 102 10^2 

 
Tabel Operator matematika Excel 2007 
 
Penggunaan operator matematika dapat dilihat dalam contoh sederhana berikut. 
Contoh: 
a. Hitunglah nilai Y berdasarkan persamaan Y = (X1 + 10)/(X2 + 20) untuk X1 dan X2 yang bernilai 
tertentu. 
Penyelesaian: 
1) Petakan imajinasi Anda ke Microsoft Excel sebagai berikut. 
• Y adalah sel C1. 
• X1 adalah sel A1. 
• X2 adalah sel B1. 
2) Ubah rumus pada soal ke dalam format penulisan rumus Microsoft 
Excel di sel C1, yaitu =(A1 +10)/(B1 + 20). 
3) Kliklah sel C1. 
4) Ketikkan “=(A1+10)/(B1+20)”. 
 
 

 
Gambar Penulisan rumus dalam Microsoft Excel 
 
5) Masukkan angka pada sel A1 dan B1. Misalnya, A1 = 30, B1 = 20. 
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Selanjutnya, perhatikan nilai yang muncul pada sel C1. Secara otomatis Calc akan menghitung rumus 
pada sel C1 dan memberikan nilai keluaran sebesar 1. 
 

 
Gambar Penggunaan rumus matematika pada Microsoft Excel 
 
Dalam menuliskan rumus pada lembar kerja Microsoft Excel, kita harus berhati-hati. Penulisan yang 
tidak tepat dapat menyebabkan hasil tidak muncul atau berbeda dengan rumus yang dimaksud. 
Berikut adalah contoh penulisan rumus yang dapat memberikan nilai keluaran yang berbeda dengan 
rumus =(A1+10)/(B1+20). 
• =A1+10/B1+20 
• =(A1+10/B1+20) 
• =A1+10/(B1+20) 
• =(A1+10)/B1+20 
 
 
b. Tentukan nilai dari hitungan matematika untuk data pada tabel berikut! 
 

 
Penyelesaian: 
Untuk mengerjakan soal di atas, kita dapat menggunakan operasi hitungan matematika pada 
umumnya. Misalnya, hasil perhitungan A x B x C dapat ditentukan dengan menggunakan rumus 
=An*Bn*Cn. Untuk hitungan matematika (A x B) + C dapat ditentukan dengan menggunakan rumus 
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=(An*Bn)+Cn. Di mana n menunjukkan posisi sel dari data yang akan dihitung. Berikut ini dijelaskan 
langkah-langkah untuk mengerjakan soal di atas. 
1) Klik sel D3 
2) Masukkan rumus fungsi matematika =A3*B3*C3, kemudian tekan enter. 

  
3) Klik pojok kanan bawah sel D3, kemudian drag atau tarik sampai sel D7. Hasil perhitungan 
otomatis akan muncul pada setiap sel dari D4 sampai D7. 

  
4) Klik sel E3, kemudian masukkan rumus fungsi matematika =(A3*B3)+C3 lalu tekan enter. 

  
5) Klik pojok kanan bawah sel E3, kemudian drag atau tarik sampai sel E7. Hasil perhitungan 
otomatis akan muncul pada setiap sel dari E4 sampai E7. 
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Selain operator matematika seperti contoh di atas, terdapat pula fungsi matematika yang biasa 
digunakan dalam Microsoft Excel. Fungsi matematika dan trigonometri yang sering digunakan pada 
Microsoft Excel dapat dibaca pada tabel berikut. 

Fungsi Matematika Kegunaan 

ABS Menghasilkan nilai absolut. 

INT Membulatkan nilai ke bilangan genap terdekat. 

ROUND Membulatkan nilai ke bilangan desimal yang ditentukan. 

EVEN Membulatkan nilai ke bilangan genap terdekat ke atas. 

ROUNDOWN Membulatkan suatu bilangan ke bawah. 

ROUNDUP Membulatkan suatu bilangan ke atas. 

SORT Menghasilkan akar kuadrat. 

COUNTA Menghitung sel tak kosong pada satu range. 

COUNTIF Menghitung jumlah data dalam suatu range menurut kriteria. 

RANK Mengurutkan posisi tingkatan dari suatu bilangan 

MOD Menghasilkan sisa pembagian 

 
Tabel Fungsi matematika pada Excel 2007 dan kegunaannya 
 
 
B.Fungsi Logika Microsoft Excel 2007 
Dalam melakukan perhitungan, seringkali ditemukan adanya beberapa pilihan yang harus 
ditentukan. Sebagai contoh, dari nilai mahasiswa akan ditentukan apakah mahasiswa tersebut lulus 
atau tidak, dan jika lulus apakah predikat dari nilainya tersebut. Dalam menangani hal ini telah 
disediakan fungsi untuk percabangan, yaitu dengan mengunakan fungsi IF. Fungsi ini digunakan 
untuk menguji suatu kondisi atau logika, yang akan menentukan nilai kembali ke-1 jika kondisi 
tersebut bernilai benar dan menentukan nilai kembali ke-2 jika kondisi tersebut salah. Cara 
penggunaan: 
=IF(Kondisi;[Nilai_Jika_Benar];[Nilai_Jika_Salah]) 
 

Keterangan:  

Kondisi Suatu ungkapan logika yang berupa perbandingan. 

Nilai_Jika_Benar Nilai yang dihasilkan jika pengujian kondisi bernilai benar. 

Nilai_Jika_Salah Nilai yang dihasilkan jika pengujian kondisi bernilai salah. 
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Sebagai contoh, dalam menampilkan status kelulusan mahasiswa dengan melihat nilai ujian yang 
sudah dijalaninya sebagai berikut. 

 
Gambar Data awal untuk mencari status kelulusan 
 
Untuk mendapatkan status “LULUS” mahasiswa harus mempunyai nilai lebih besar dari 50. Jika 
nilainya kurang dari 50, maka akan diberi status “TIDAK LULUS”. 
a. Penggunaan Fungsi IF 
Untuk dapat menyelesaikannya dibutuhkan fungsi logika, yaitu fungsi IF. Untuk lebih jelasnya, 
berikut disampaikan beberapa paparan tentang penggunaan fungsi IF. Fungsi IF dengan format 
lengkap adalah sebagai berikut. 
IF(logical_test;value_if_true;value_if_false) 
Keterangan: 
logical_test merupakan syarat dari percabangan. 
value_if_true merupakan nilai jika syarat percabangan terpenuhi. 
value_if_false merupakan nilai jika syarat percabangan tidak terpenuhi. 
Langkah-langkah untuk menyelesaikannya melalui function wizard adalah sebagai berikut. 
1) Klik pada sel D3. 
2) Klik Formulas, pilih Logical, kemudian klik fungsi IF. 

  
Gambar Pemilihan Fungsi IF melalui Category Logical. 
3) Ubah setting pada kotak dialog fungsi IF seperti berikut. 
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Gambar Setting melalui function wizard 
 
Pada Logical Test ditulis C3 > 50 adalah karena di sel C3-lah letak dari nilai yang akan dilakukan 
penyeleksian. Ketikkan syaratnya pada isian logical_test, misalnya C3>50 yang artinya jika data di sel 
C3 lebih besar atau sama dengan 50 maka bernilai benar dan jika kurang dari 50 maka bernilai salah. 
Ketikkan teks “Lulus” pada isian value_if_true, yang artinya jika pada logical_test bernilai benar 
maka teks ini yang akan dihasilkan/dikeluarkan. Ketikkan teks “Tidak Lulus” pada isian value_if_false, 
yang artinya jika pada logical_test bernilai salah maka teks ini yang akan dihasilkan/dikeluarkan. 
4) Klik OK. Copy-kan formula ke sel di bawahnya. 
Pemberian tanda “ ” merupakan tambahan jika ingin menambahkan statement berupa kalimat atau 
string. Didapatkan hasil akhir seperti gambar berikut. 

  
Gambar Hasil akhir pemberian status kelulusan 
 
b. Percabangan beberapa Tingkat 
Percabangan tidak hanya pemisahan menjadi dua kemungkinan saja, namun juga bisa menjadi 
banyak kemungkinan. Untuk percabangan yang memisahkan ke banyak kemungkinan harus 
menggunakan IF secara bertingkat. 
 
 
Tabel Fungsi Logika 

Fungsi Keterangan 

IF Menentukan suatu tes logika untuk dikerjakan, dan mempunyai bentuk: 
=IF(tes logika, nilai jika benar, nilai jika salah) 
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AND, OR, 
dan 
NOT 

Merupakan fungsi tambahan untuk mengembangkan tes kondisi. Fungsi AND dan OR 
maksinal berisi 30 argumen logika, sedangkan NOT hanya mempunyai satu argumen 
logika, mempunyai bentuk: 
AND (logika1,logika2, …,logika30) 
OR (logika1,logika2, …,logika30) 
NOT (logika) 

 
Pembahasan fungsi IF di atas dengan Tes Logika Tunggal, Tes Logika dapat dikembangkan dengan 
tambahan salah satu fungsi AND, OR, atau NOT. Bentuk fungsi IF dengan tes logika yang 
dikembangkan adalah sebagai berikut. 
= IF (OR(Tes Logika1;Tes Logika2);Nilai jika benar;Nilai jika salah) 
Contoh: 
Sebuah perusahaan akan merekrut tenaga satuan pengaman (satpam) dengan ketentuan 
pengalaman kerja minimal empat tahun dan usia maksimal 35 tahun. Perusahaan melakukan seleksi 
administrasi dengan kriteria tersebut. Pelamar yang memenuhi syarat akan mengikuti seleksi 
selanjutnya, sedangkan yang tidak memenuhi syarat dinyatakan gugur. Kasus tersebut dapat 
diterjemahkan ke dalam fungsi IF seperti berikut ini. 
= IF(AND(Kerja>=4;Usia<=35);Wawancara;Gugur) 
Fungsi tambahan adalah AND karena kedua tes logika merupakan kriteria yang harus terpenuhi, 
perhatikan penerapan fungsi tersebut dalam baris rumus worksheet. 
 

 
Gambar Fungsi IF dengan 2 tes logika 
Istilah fungsi IF bercabang adalah kasus yang mempunyai banyak tingkat pengujian tes logika yang 
diselesaikan dengan fungsi IF. Sebagai contoh sebuah lembar kerja berisi data hasil ujian statistik. 
Berdasarkan nilai ujian akan dikonversikan dalam bentuk huruf dengan ketentuan sebagai berikut. 
 

Nilai Huruf 

0 – 59 E 

60 – 74 D 

75 – 84 C 

85 – 94 B 

95 – 100 A 

 
Perhatikan penyelesaian dengan fungsi IF dalam lembar kerja seperti pada gambar berikut. 
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Gambar Contoh fungsi IF bercabang 
Sel E5 diisi dengan rumus: 
=IF(D5<60;”E”;IF(D5<75;”D”;IF(D5<85;”C”;IF(D5<95;”B”;”A”)))) 
 
c. Mencari Jumlah 
Kadangkala diperlukan sebuah informasi untuk menampilkan berapa jumlah data yang memenuhi 
kriteria tertentu. Misalnya, dalam sebuah daftar nilai ingin diketahui berapa orang yang mendapat 
nilai “A”. Untuk itu telah disediakan sebuah fungsi sebagai berikut. 
=COUNTIF(range,criteria) 
Di mana pada area yang disebutkan di range akan dicari berapa jumlah sel yang sesuai dengan 
kriteria. Contoh =COUNTIF(B2:B57,”A”) artinya dicari berapa jumlah sel yang berisi “A” pada range 
B2 sampai B57. Pada contoh sebelumnya, dikembangkan untuk mencari jumlah lulus dan tidak lulus, 
sehingga nantinya data akan menjadi seperti di bawah ini. 

  
Gambar Hasil akhir penambahan fungsi COUNTIF 
Untuk dapat menambahkan hasil tersebut, lakukan penambahan fungsi COUNTIF pada C9 sebagai 
berikut  
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